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Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its subsidiaries or suppliers, and are
protected by national copyright laws and international treaty provisions.

Tektronix products are covered by U.S. and foreign patents, issued and pending. Information in this publication supersedes that in all
previously published material. Specifications and price change privileges reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.

Contacting Tektronix

Tektronix, Inc.

14150 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:
= In North America, call 1-800-833-9200.
= Worldwide, visit www.tektronix.com to find contacts in your area.


http://www.tektronix.com/contact

Warranty

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and
replacement products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced

parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the
defective product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall
be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and
care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel
other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or
connection to incompatible equipment; ¢) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or

d) to service a product that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the media will be
free from defects in materials and workmanship for a period of three (3) months from the date of shipment. If any such medium or
encoding proves defective during the warranty period, Tektronix will provide a replacement in exchange for the defective medium.
Except as to the media on which this software product is furnished, this software product is provided “as is” without warranty of any
kind, either express or implied. Tektronix does not warrant that the functions contained in this software product will meet Customer's
requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty
period. If Tektronix is unable to provide a replacement that is free from defects in materials and workmanship within a reasonable
time thereafter, Customer may terminate the license for this software product and return this software product and any associated
materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND
CUSTOMER'S PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF

THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE
POSSIBILITY OF SUCH DAMAGES.
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IMPORTANT
READ BEFORE OPERATING EQUIPMENT

This software is provided under license from Tektronix, Inc. Retention of this program for more than thirty (30) days or use of the
program in any manner constitutes acceptance of the license terms.

CAREFULLY READ THE ENCLOSED SOFTWARE LICENSE AGREEMENT. If you cannot agree to the license terms,
promptly contact the nearest Tektronix Field Office for return assistance.

TEKTRONIX SOFTWARE LICENSE AGREEMENT

THE PROGRAM, OR PROGRAMS, ENCODED OR INCORPORATED WITHIN EQUIPMENT, IS FURNISHED SUBJECT TO

THE TERMS AND CONDITIONS OF THIS AGREEMENT. RETENTION OF THE PROGRAM FOR MORE THAN THIRTY DAYS
OR USE OF THE PROGRAM IN ANY MANNER WILL BE CONSIDERED ACCEPTANCE OF THE AGREEMENT TERMS. IF
THESE TERMS ARE NOT ACCEPTABLE, THE UNUSED PROGRAM AND ANY ACCOMPANYING DOCUMENTATION SHOULD
BE RETURNED PROMPTLY TO TEKTRONIX FOR A FULL REFUND OF THE LICENSE FEE PAID. (FOR INFORMATION
REGARDING THE RETURN OF PROGRAMS ENCODED OR INCORPORATED WITHIN EQUIPMENT, CONTACT THE NEAREST
TEKTRONIX SALES OFFICE.)

DEFINITIONS. "Tektronix" means Tektronix, Inc., an Oregon corporation, or local Tektronix' legal entity that is supplying the
equipment.

"Program" means the Tektronix software product (executable program and/or data) enclosed with this Agreement or included within the
equipment with which this Agreement is packed.

"Customer" means the person or organization in whose name the Program was ordered.

LICENSE. Customer may:

1.
2.

Use the Program on a single machine at any one time;

If the Program is provided in connection with a floating-user license, the Program may be used on multiple machines provided that
the user is authorized, and the total number of users at any one time does not exceed the total number of licensed concurrent users;

Modify the Program or merge it with another for use on the single machine; and

Copy the Program for archival or backup purposes, provided that no more than one (1) such copy is permitted to exist at any one
time. If the Program is provided in connection with a floating-user license, the Program may be copied onto multiple machines
for use by authorized users.

Each copy of the Program made by Customer must include a reproduction of any copyright notice or restrictive rights legend appearing
in or on the copy of the Program as received from Tektronix.

Customer may not:

1.
2.

Use the Program on more than one machine at any one time, unless covered by a floating-user license or separate site license;

Transfer the Program to any person or organization outside of Customer or the corporation of which Customer is a part without
the prior written consent of Tektronix, except in connection with the transfer of the equipment within which the programs are
encoded or incorporated,;

Export or reexport, directly or indirectly, the program, any associated documentation, or the direct product thereof, to any country to
which such export or reexport is restricted by law or regulation of the United States or any foreign government having jurisdiction
without the prior authorization, if required, of the Office of Export Administration, Department of Commerce, Washington, D.C.

and the corresponding agency of such foreign government;



4. For object-code Programs only, reverse compile or disassemble the Program for any purpose; or
5. Copy the documentation accompanying the Program.

For Programs designed to reside on a single-machine and support one or more additional machines, either locally or remotely, without
permitting the Program to be transferred to an additional machine for local execution, the additional machines shall be considered
within the definition of "single machine". For programs permitting the Program to be transferred to an additional machine for local
execution, a separate license shall be required for each such machine with which the Program may be used, or each concurrent user
authorized under a floating-user license.

Title to the Program and all copies thereof, but not the media on which the Program or copies may reside, shall be and remain with
Tektronix or others for whom Tektronix has obtained a respective licensing right.

Customer shall pay when due all property taxes that may now or hereafter be imposed, levied or assessed with respect to the
possession or use of the Program or this license and shall file all reports required in connection with such taxes.

Any portion of the Program modified by Customer or merged with another program shall remain subject to these terms and conditions.

If the Program is acquired by or for an agency of the U.S. Government, the Program shall be considered computer software developed
at private expense and the license granted herein shall be interpreted as granting Customer restricted rights in the Program and related
documentation as defined in the applicable acquisition regulation.

THE PROGRAM MAY NOT BE USED, COPIED, MODIFIED, MERGED, OR TRANSFERRED TO ANOTHER EXCEPT AS
EXPRESSLY PERMITTED BY THESE TERMS AND CONDITIONS.

UPON TRANSFER OF ANY COPY, MODIFICATION, OR MERGED PORTION OF THE PROGRAM, THE LICENSE GRANTED
HEREIN IS AUTOMATICALLY TERMINATED.

TERM. The license granted herein is effective upon acceptance by Customer, and shall remain in effect until terminated as provided
herein. The license may be terminated by Customer at any time upon written notice to Tektronix. The license may be terminated

by Tektronix or any third party from whom Tektronix may have obtained a respective licensing right if Customer fails to comply with
any term or condition and such failure is not remedied within thirty (30) days after notice hereof from Tektronix or such third party.
Upon termination by either party, Customer shall return to Tektronix or destroy, the Program and all associated documentation,
together with all copies in any form.

LIMITED WARRANTY. Tektronix warrants that the media on which the Program is furnished and the encoding of the Program
on the media will be free from defects in materials and workmanship for a period of three (3) months from the date of shipment. If
any such medium or encoding proves defective during the warranty period, Tektronix will provide a replacement in exchange for the
defective medium. Except as to the media on which the Program is furnished, the Program is provided "as is" without warranty of
any kind, either express or implied. Tektronix does not warrant that the functions contained in the Program will meet Customer's
requirements or that the operation of the Program will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period. If
Tektronix is unable to provide a replacement that is free from defects in materials and workmanship within a reasonable time thereafter,
Customer may terminate the license for the Program and return the Program and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PROGRAM IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA, OR REFUND
CUSTOMER'S PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS
WARRANTY.

LIMITATION OF LIABILITY, IN NO EVENT SHALL TEKTRONIX OR OTHERS FROM WHOM TEKTRONIX HAS OBTAINED A
LICENSING RIGHT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT
OF OR CONNECTED WITH CUSTOMER'S POSSESSION OR USE OF THE PROGRAM, EVEN IF TEKTRONIX OR SUCH OTHERS
HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.



THIRD-PARTY DISCLAIMER. Except as expressly agreed otherwise, third parties from whom Tektronix may have obtained a
licensing right do not warrant the program, do not assume any liability with respect to its use, and do not undertake to furnish any
support or information relating thereto.

GENERAL. This Agreement contains the entire agreement between the parties with respect to the use, reproduction, and transfer of
the Program.

Neither this Agreement nor the license granted herein is assignable or transferable by Customer without the prior written consent
of Tektronix.

This Agreement and the license granted herein shall be governed by the laws of the state of Oregon.

All questions regarding this Agreement or the license granted herein should be directed to the nearest Tektronix Sales Office.

ADDITIONAL LICENSE GRANT FOR VIDEO TEST SEQUENCES. The Software Product may include certain test patterns,
video test sequences and video clips (together “Video Test Sequences”). If so, the following terms describe Your rights to the
Video Test Sequences:

You may use, copy and modify the Video Test Sequences and display or distribute copies of individual Video Test Sequences in
connection with Your video testing activity.

You are not licensed to do any of the following:

1. You may not distribute the collection of Video Test Sequences, except in connection with the sale of original equipment containing
the Video Test Sequences, without prior written permission from Tektronix.

2. You may not permit third parties to distribute copies of the Video Test Sequences.

3. You may not sell, license or distribute copies of the Video Test Sequences on a standalone basis or as part of any collection,
product, or service where the primary value of the product or service is the Video Test Sequences.

You must indemnify, hold harmless, and defend Tektronix from and against any claims or lawsuits, including attorneys’ fees, that arise
from or result from the use or distribution of Video Test Sequences as modified by You.

You must include a valid copyright notice on Your products and services that include copies of the Video Test Sequences.
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General Safety Summary

General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the
product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category I, Ill, or IV circuits.
Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Power disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it
must remain accessible to the user at all times.

Do not operate without covers. Do not operate this product with covers or panels removed.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.
Wear eye protection. Wear eye protection if exposure to high-intensity rays or laser radiation exists.
Do not operate in wet/damp conditions.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry.

Provide proper ventilation. Refer to the manual's installation instructions for details on installing the product so it has
proper ventilation.
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General Safety Summary

Terms in This Manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

c CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product

These terms may appear on the product:

= DANGER indicates an injury hazard immediately accessible as you read the marking.

= WARNING indicates an injury hazard not immediately accessible as you read the marking.
= CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:

A © O | O

CAUTION Protective Ground  Mains Disconnected  Mains Connected  ggandh
Refer to Manual {Earth) Terminal OFF (Power) ON (Power) andby
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Compliance Information

Compliance Information

This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC Compliance
EC Declaration of Conformity - EMC

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326-1:2006. EMC requirements for electrical equipment for measurement, control, and laboratory use. 123
= CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A

m |EC 61000-4-2:2001. Electrostatic discharge immunity

B |EC 61000-4-3:2002. RF electromagnetic field immunity 4

= |EC 61000-4-4:2004. Electrical fast transient / burst immunity

= |EC 61000-4-5:2001. Power line surge immunity

m |EC 61000-4-6:2003. Conducted RF immunity

® |EC 61000-4-11:2004. Voltage dips and interruptions immunity

EN 61000-3-2:2006. AC power line harmonic emissions
EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European Contact.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 To ensure compliance with the EMC standards listed here, high quality shielded interface cables should be used.

4 The MTS4000 meets the requirements of the harmonized standards listed above when configured with all interface cards except
option QB2 (QAM Annex B). Specific conditions for RF electromagnetic field immunity apply to this option as follows. When
demodulating QAM-256 constellation signals, the QAM Annex B card can be susceptible to radiated electromagnetic fields at levels
below those in EN 61326-1 Table 1 for IEC 61000-4-3. This only occurs in a very narrow frequency band that is 44 MHz (the QAM
tuner local oscillator frequency) higher than the tuned input frequency. Because of the high sensitivity of the QAM demodulator in
this mode, RF lock may be lost, or stream errors may occur. For best performance, use only high quality well shielded cables to
connect to the MTS4000, and avoid the use of cable adapters.
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Compliance Information

Australia / New Zealand Declaration of Conformity — EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

®  CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in accordance with EN 61326-1:2006.

Australia / New Zealand contact.

Baker & McKenzie

Level 27, AMP Centre

50 Bridge Street

Sydney NSW 2000, Australia

Safety Compliance
EC Declaration of Conformity - Low Voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Communities:
Low Voltage Directive 2006/95/EC.

= EN61010-1: 2001. Safety requirements for electrical equipment for measurement control and laboratory use.

U.S. Nationally Recognized Testing Laboratory Listing
UL 61010-1:2004, 2nd Edition. Standard for electrical measuring and test equipment.

Canadian Certification

m CAN/CSA-C22.2 No. 61010-1:2004. Safety requirements for electrical equipment for measurement, control, and
laboratory use. Part 1.

Additional Compliances

m |EC61010-1: 2001. Safety requirements for electrical equipment for measurement, control, and laboratory use.

Equipment Type

Test and measuring equipment.

Safety Class

Class 1 - grounded product.
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Compliance Information

Pollution Degree Description

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

®  Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

®m  Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.

m  Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

B Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.

Pollution Degree
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor use only.

Installation (Overvoltage) Category Descriptions

Terminals on this product may have different installation (overvoltage) category designations. The installation categories are:
= Measurement Category IV. For measurements performed at the source of low-voltage installation.

B Measurement Category lll. For measurements performed in the building installation.

E  Measurement Category Il. For measurements performed on circuits directly connected to the low-voltage installation.

B Measurement Category I. For measurements performed on circuits not directly connected to MAINS.

Overvoltage Category
Overvoltage Category Il (as defined in IEC 61010-1)

Environmental Considerations

This section provides information about the environmental impact of the product.

Product End-of-Life Handling

Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The equipment
may contain substances that could be harmful to the environment or human health if improperly handled at the product's end of
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Compliance Information

life. In order to avoid release of such substances into the environment and to reduce the use of natural resources, we encourage
you to recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2002/96/EC and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Mercury notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due to
environmental considerations. Please contact your local authorities or, within the United States, refer to the E-cycling Central
Web page (www.eiae.org) for disposal or recycling information.

Restriction of Hazardous Substances

This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive.
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Preface

Preface

This manual describes the functions and use of the Tektronix MTS4000 MPEG Test Systems. The following naming

conventions are used in this manual:

®  MTS4000 system — for information that applies to the MTS4000 and the MTS4SA
B MTS4SA Stand-alone system — for information that applies to only the MTS4SA

Key Features

B Supports a wide range of DTV standards, including MPEG, DVB, ATSC, and ISDB. Specific Sl for Terrestrial, Cable
and Satellite, and regional variations of these standards.

B  Arange of interfaces and analysis capabilities provide the necessary connectivity to diagnose problems anywhere in the
network environment, including RF or IP layer transmission links or transport stream content processing.

®  Connects to both IP version 4 and 6 networks, including those using IGMP and MLD multicast protocols.

m  Analysis of Constant Bit Rate Streams (CBR).

B |ntegrated cross-layer fault analysis and logging provide a single box solution for fault diagnosis, reducing time

to insight when troubleshooting.

= The playout functionality provides stimulus with parametric capabilities and IP multisession replication to characterize
behavior of a network or device under test.

= CaptureVu™ technology captures and analyzes system events in real-time and deferred-time to debug intermittent and

complex problems.

= Aninnovative program-centric user interface brings expert power to the novice user.

= H.264 buffer analysis, multiplexing and elementary stream compliance checking provide a powerful suite of tools for
creation and analysis of transport streams containing H.264 content.

= Video and audio quality analysis to help distinguish between impairments resulting from network distribution versus

artifacts resulting from compression.

= Multi input monitoring.

Documentation

This manual describes the installation and basic operation of the MTS4000 system. The following information is also

available for this product:

Item

Purpose

Location

MTS4000 Quick Start User Manual
(071-2970-xx English, 077-0665-xx
Simplified Chinese, 077-0666-xx
Japanese, 077-0657-xx Russian)

Describes how to install and get
started using the test systems.

@ + M=

www. Tektronix.com

MTS4000 Analyzer Applications User
Manual (077-0622-xx)

Describes the operation of the
following analyzer applications:
TSCA, PES Analyzer, T-STD

Buffer Analyzer, and ES Analyzer.

= 4 == [

www. Tektronix.com
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Preface

Item Purpose Location
MTS4000 Generator Applications Describes the operation of the
User Manual (077-0623-xx) following generator applications: @> + - Ex '
Multiplexer, MPEG Player, TS www_Tektronix.com
Editor, Make Seamless Wizard,
Transport Stream Cutter, and
Script Pad.
MTS4000 Carousel Applications User Describes the operation of the S
Manual (077-0624-xx) Carousel Analyzer and Carousel @> + - Ex '
Generator applications. www.Tekironix.com
MTS4000 MPEG Test Systems Provides a list of product S
Specifications and Performance specifications and verification @> + “Ea

Verification Technical Reference
(077-0626-xx)

procedures.

www. Tektronix.com

MTS4000 Release Notes

Describes known issues with the

(077-0200-xx) test systems. :
www.Tektronix.com

MTS4EA Compressed Video Describes the operation of the e
Elementary Stream Analyzer User MTS4EA application software. @> + B '
Manual (071 '1641'XX) wW.Teklronix.com
MTS4CC Elementary Stream Describes the operation of the R
Compliance Checker User Manual MTS4CC application software. @> + —Ea
(071-2075-xx) wwen Tektronix com
PQA600 Picture Quality Analyzer Describes the operation of the S
Quick Start User Manual PQA600 application software. @> + —Ea
(071-2775-xx) wwen Tektronix com
VQS1000 Video Quality Software Describes the operation of the S
Quick Start User Manual VQS1000 application software. @> + = B :

(077-0489-xx)

www. Tektronix.com

User documents can be downloaded from the Tektronix Web site: www.tektronix.com/manuals.

The following URLs access the Web sites for the standards organizations listed (the URLSs listed were valid at the time of

writing):

®  MPEG-2 standards (International Organization for Standards) — www.iso.org/

m DVB standards (European Technical Standards Institute) — www.etsi.org/

B ATSC standards (Advanced Television Systems Committee) — www.atsc.org/

MTS4000 and MTS4SA Quick Start User Manual
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Preface

Conventions Used in This Manual

The following icons may be used throughout this manual.

Sequence Front panel Connect Network PS2 SVGA USB
Step power power

w0 000C
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Installation

Before Installation
Perform the following product inspection procedure when you receive your instrument.
1. Inspect the shipping carton for external damage, which indicates possible damage to the instrument.
2. Remove the MTS4000 instrument from the shipping carton.

3. Check that the instrument has not been damaged in transit. The exterior should not have any scratches or impact marks.
Before shipment, the instrument is thoroughly inspected for mechanical defects.

NOTE. Save the shipping carton and packaging materials for instrument repackaging in case shipment becomes necessary.
(See page 69, Returning the Instrument for Service.)

4. Verify whether you received the standard accessories and any optional accessories that you ordered. (See page 61,
Accessories.)

Operating Considerations

The following table lists the electrical operating requirements for the MTS4000 systems. The complete electrical operating
requirements of the MTS4000 instrument are listed in the MTS4000 MPEG Test Systems Specifications and Performance
Veerification Technical Reference.

Requirement Specification

Operating temperature +5°Cto+40°C

Operating altitude 0 to 2000 m (6562 ft)

Operating humidity 20% to 80% relative humidity, non-condensing

Source Voltage 100 to 240 Vac £ 10% (90 to 264 Vac RMS)

Frequency range 50/60 Hz

Maximum Power Consumption 220 Watts

Fuse Not operator replaceable. Refer servicing to qualified service personnel
Overvoltage category Il (as defined in IEC 61010-1)

Pollution degree 2 (as defined in IEC 61010-1). Rated for indoor use only

MTS4000 and MTS4SA Quick Start User Manual 1



Installation

Controls and Connectors

This section describes the MTS4000 system instrument controls and connectors. The analysis functions (if enabled) can
be used with no installation other than providing power and making a transport stream available on the hard disk of the
instrument. The monitoring and real-time analysis functions similarly require power, but also require connection to an
external transport stream.

The MTS4000 system is configured with the software and hardware options that you ordered at the time of purchase.
MTS4000 system options can be added using upgrade kits available from Tektronix.

CAUTION. To prevent instrument damage from overheating, maintain at least two inches (5.1 cm) of clearance at the rear
and sides of the instrument cabinet when locating the instrument on a bench.

c CAUTION. Do not supply power to the instrument until all other connections have been made.
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Side Connectors

The following figure and table illustrates the MTS4000 system connectors.

2970001

Figure Figure
reference Description reference Description
1 Main DVI display port (to mainframe LCD) 6 PS/2 mouse and keyboard connectors !
Secondary DVI display port?,2
2 Line Out — connected to the mainframe 7 Optional interface card bays
speaker
Line In — not functional
Mic !
USB host ports 8 RJ-45 LAN connectors
DVI, VGA Video connectors — not functional 9 AC mains power switch
COM 1 and COM 2 serial ports 10 AC mains power plug

Ensure that you use the proper power cord
for your location.

1 EMC performance is not tested with cables connected to this port.
2 The secondary display port can be used to display or extend the MTS4000 display. The display must be connected during the instrument start up.
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Front Panel Controls and Connectors

The following figure and table illustrates the MTS4000 front panel controls and connectors.

®@ @ 0666066

2670008

Figure Figure
reference Description reference Description
1 Power indicator. Flashes when in standby 5 On/Standby button
mode.
Hard drive activity indicator 6 LCD controls
Display on/off button 7 USB host ports

Restart button (recessed)

Keyboard/mouse connector
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Option Card Connectors

The MTS4000 System can be configured optional cards that support various transport streams, networks, and peripheral
devices. This section describes each of the available option cards and their connectors.

See the MTS4000 MPEG Test Systems Specifications and Performance Verification Technical Reference for more detailed
information about each connector and signal input and output formats for each of the option cards.

NOTE. Up to four option cards can be installed into the instrument, but only two of the following options: S2, VS, QB2, IPTV.

Ensure that the USB software key (dongle) is installed in one of the USB ports.

NOTE. The MTS4000 system applications and installed option cards require the software key.

If you return the test system to a Tektronix Service Center for upgrade or repair, include the software key.

Table 1: Option cards and connectors

Multiport ASI Interface (Option ASI)
Connectors: BNC, 75 Q

O O O O Quad
AslisDI
1 2 3 4

2790009

DVB-S/S2 Interface (Option S2)
DVB-S/S2 interface supporting QPSK,

8PSK, 16APSK and 32APSK demodulation @ (o)
(requires Option ASI) <\ 5@

8VSB Interface (Option VS)

8VSB interface in accordance wit ATSC
A/53B (requires Option ASI)

O poier
DVB-S2
RFIN

O oo

2790005

asy N
MPTE
i out
8VSB
RFIN
IN
LOCK

2790008

QAM B Interface (Option QB2)

64QAM, 256QAM Interface (requires Option
ASI)

5
QAM-B
©
0

2790007

10GBase-SR Dual Optical Port 10GB/S NIC (Option 10GS)

10GBase-SR Dual Optical Port 10 Gbps NIC.
Includes Short Reach SFP+ and Modules
(850 nm)

10G
10G

O

=)

OGRN

[elfol £ |lelle)

OACTILNK A

OGRN

OACTILNK B
O

2790010
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IP Video Interface (Option IPTV)

IPTV Gigabit Ethernet Interface with OO
10/100/1000 Base-T RJ45 Electrical Port = ﬁ
(requires Option ASI) O

RJ-45

INPUT
OUTPUT
ASl/
SMP TE310M

GbE
SFP
LINK

2790008

SFP Modules (Options SX, LX, ZX)

1000 Base-SX Short Wavelength Optical g =
Port with LC Connector for IPTV Ethernet s —
Interface (Multi Mode 850 nm)

1000 Base-LX Long Wavelength Optical
Port with LC Connector for IPTV Ethernet
Interface (Single Mode 1310 nm)

1000 Base-ZX Optical Port with LC
Connector for IPTV Ethernet Interface
(Single Mode 1550 nm)

The optical port plug must be installed in the SFP module when no cable is connected.

To avoid exposure to hazardous laser radiation, use only Class 1 lasers as defined in the USA Federal Regulations CDRH
21 CFR 1040 and IEC/EN 60825/A2:2001.

MTS4SA Stand-Alone System Installation

The MTS4SA Stand-alone system makes the MTS4000 system applications available on a PC.

The MTS4SA includes a USB dongle. When installed on your PC, the USB dongle contains the keys to enable various
MTS4000 software options. The keys stored on the USB dongle depends on which software options you purchased.

If the MTS4EA option (MTS4EA Compressed Video ES Analyzer) was purchased, use the installation procedure provided in
the accompanying user manual (MTS4EA Compressed Video ES Analyzer User Manual, 071-1641-XX).

System Requirements

The following minimum PC configuration is recommended for installing the MTS4SA Stand-alone system:
B Microsoft Windows XP or Windows 7 operating system

m  Processor speed >1.2 GHz

= Memory at least 1 GB RAM

m  Screen resolution at least 1024 x 768

® 1 GB minimum hard disk space

NOTE. The MTS4EA MPEG Compressed Video ES Analyzer application will run satisfactorily on a PC with the preceding
specifications. However, some of the more intensive operations will benefit from using a more powerful PC. Refer to the
MPEG Compressed Video ES Analyzer User Manual for more details.
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Installation Procedure

1. Ensure that the USB software key
(dongle) supplied is inserted into a USB
port on the PC.

@ Welcome to the Tektronix MTS4000
2. Place the MTS4000 Application Software Setup Wizard

media in the DVD drive on your PC.

The installation program will start and
display a Welcome screen.

Depending on your Windows setup
and security settings, the MTS4000
installation autostart may not launch.

If necessary, you can use Windows
explorer to locate and run the

file MTS4000_setup.exe on the
MTS4000 Application Software media.

{7 Tektronic MTS4000 Setup =101

The Setup Wizard will install Tektronix MTS4000 on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard.

3. In the installation Welcome screen,

select Next. Back Cancel |
4. Read the End-User License Agreement. 141 Tektronix MTS4000 Setup = — %
Accept the agreement and select Next.
End-User License Agreement
Please read the following license agreement carefully

IMPORTANT
READ BEFORE OPERATING EQUIPMENT

This software is provided under license from Tektronix, Inc.
Retention of this program for more than thirty (30) days or
use of the program in any manner constitutes acceptance of
the license terms.

CAREFULLY READ THE ENCLOSED SOFTWARE -

¥ 1 accept the terms in the License Agreement:

Brint Back | Mext | Cancel
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5. In the Setup Type screen, you need to
indicate if this installation is for a PC or
for the MTS4000 platform.

Installing on a PC:

Uncheck the Install on MTS4000 Platform
check box.

| Install on MTS4000 Platform

Installing on the MTS4000 platform:
Check the Install on MTS4000 Platform
check box.

IV Install on MT54000 Platform

NOTE. When the Install on MTS4000
Platform is checked, all necessary drivers for
the interface cards are installed.

6. Select Next.

7. In the Ready to Install screen, select
Install.

If the installation program detects an older

version of the MTS4000 software, the

software is automatically uninstalled.

45 Tektronix MTS4000 Setup

Choose Setup Type
Choose the setup type that best suits your needs

[ Install on MTS4000 Platform:

Back | Mext | Cancel

=10l

it Tektronix MTS4000 Setup

Ready to install Tektronix MTS4000

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

E——— Cancel

NOTE. A number of installation message boxes display during the installation process. Normally, no user intervention is

required.
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8 Allow the instllation fo proceed. =1l

Installing Tektronix MTS4000 @

Please wait while the Setup Wizard installs Tektronix MTS4000.

Status: Copying new files
[TL]]]

Back [Ext

9. Depending on the Windows security Windows Security
settings, you may see a Windows
Security message to install device Would you like to install this device software?
software. Select Install. . MName: Data Encryption Systems Limited DESkey
This installation window does not display @ Publisher: Data Encryption Systems Ltd
if DESkey software is installed.

[7] Always trust software from "Data Encryption Install ] [ Don't Install J
Systems Ltd".

@' You should enly install driver seftware from publishers you trust. How can I decide which
device software is safe to install?
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10. When the WinPcap installer displays, (o x|
select Nex.t. . . . u ) i WinPcap 4.1.2 Installer
Proceed with the WinPcap installation SN caP Welcome to the WinPcap 4. 1.2 Installation Wizard
process.
The WinPcap installation is skipped If the =
MTS4000 installation process detects This product is brought to you by

that the correct version WinPcap is

already installed. CA/E:_—E—

TECHNOLOGIES

Packet Capturing and Network Analysis Solutions

Iullsaft Install System w2, 46

1. When installation_cgmpleted screen T ————— _io x|
displays, select Finish.

A reboot is necessary before using the Completed the Tektronix MTS4000 Setup
applications. @ Wizard

Click the Finish button to exit the Setup Wizard.

Back Zancel
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12.

13.

14.
15.

When the PC has restarted, the
MTS4000 Option Key Wizard must
be started; select Start > Programs
> Tektronix MTS4000 > OptionKey
Wizard.

In the Tektronix Option Update dialog
box, enter the Option Key String supplied
with the installation documentation in the
Key String field.

Click Apply.

Inspect and verify the list of licensed
options.

Installation

& Tektronix Option Update @

MPEG Applications '|

Cptions

" TSCA Unlimited File Analysis V2.0 -
" TSCA IP Analysis V2.0

" TSCA Limited File Analysis V2.0
v TSCA Real Time Analysis V2.0
" TSCA Customer Option E V2.0
/Camusel (Generator V2.2
/Camusel Analyzer V1.5

v AAC Player/Analyzer V1.7
fCIosed Caption Analysis V1.7
v Multiplexer V4.3

/Make Seamless V2.0

v FES Analyser V7.1

/ StreamEditor V7.1

v Player V11,0

v Buffer Analyzer V9.0 -
Fl 171 3

m

Serial Number: VIDD50000-399595-0FAG

Key String: |

Key Status: [Valid Key

Apply | Close |

NOTE. Operational access to features is controlled by the licenses that are available on the software key. Applications and
features can be installed, but will not be available unless the appropriate license has been obtained. Notification of these is
provided when the product or additional licenses are purchased.

The MTS4EA and MTS4CC licensing is stored in the USB dongle. The VQS and PQA software require separate licensing.

16.

17.

Close the Option Key Wizard.

The licensed MTS4000 Stand-alone
applications are now available in the
Windows Start menu. (See page 24,
Starting an Application.)

MTS4000 and MTS4SA Quick Start User Manual
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Powering On the Instrument
Supplying Power

The MTS4000 systems are designed to operate from a single-phase power source having one of its current carrying
conductors at or near earth ground (the neutral conductor). Power sources that have both current carrying conductors
live with respect to ground, such as phase-to-phase or multiphase systems, are not recommended. A protective ground
connection, by way of the grounding conductor in the power cord, is essential for safe operation.

After you have installed the MTS4000 system and completed making the signal and peripheral connections, plug the power
cord into the mains power supply.

Power On

Power on the test system as follows:
1. Slide the keyboard locks up.
2. Fold down the keyboard.

3. Push the front-panel On/Standby switch
to power on the instrument.

NOTE. Ensure the Mains switch on the rear
panel is set to on.

Wiait for the instrument to complete its
power-on self-tests.

The default user name is MTS with the
password mts.

NOTE. Refer to the Windows help
documentation for setting up user accounts
and passwords.
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Detaching the Keyboard

1. Slide the keyboard pins towards the
center.

2. Slide the keyboard out from the
MTS4000 case.

2970011

Powering Off the Instrument

Push the front panel On/Standby button and release. The system will shut down and power off automatically with no
further intervention.

Alternately, power off the instrument using the Windows 7 shutdown process (select Start > Shut down...). The system
(including applications) will shut down automatically.

If the instrument should become unresponsive, press and hold the On/Standby button for five seconds. This forces the
instrument to shutdown, bypassing the Windows power down sequence.

MTS4000 and MTS4SA Quick Start User Manual
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VLC Media Player Installation

To be able to view video in the Transport Stream Compliance Analyzer (TSCA), the latest version of the VLC Media Player
must be downloaded from the VideoLAN Web site and installed.

1. Using an MTS4000 instrument
or PC with access to the internet,
navigate to the VideoLan home page
(http://www.videolan.org).

A VLC media player 0.9.4 Setup (=3

Welcome to the VLC media player
0.9.4 Setup Wizard

2. Locate and download the Windows
self-extracting VLC Media Player
installer to your PC hard disk.

This wizard will guide you through the installation of YLC
media player 0.9.4.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update

relevant system files without having to reboot your
computer.,

3. Locate the downloaded VLC Media

Player file on your instrument and run it. Click Next to confinue.

4. Select your preferred language. The
Welcome / Setup screen appears.

5. Follow the setup procedure and allow
the VLC Media Player to be installed. s M [ cance

No further activity is required. The VLC Media Player will be used by the TSCA application as required.

Network Installation

The MTS4000 system can be attached to a computer network. Refer to your Network Administrator for details of the
correct network configuration. For installation and operating instructions, refer to the documentation supplied with your
network hardware and software.

Network Troubleshooting

Networks are based on standards; however, there are many unique characteristics of each network (LAN or WAN) that
make it difficult to troubleshoot without a thorough knowledge of the specific network. Consequently, an expert who knows
your network characteristics should perform in-depth network troubleshooting.

This section provides some basic procedures that can eliminate some of the more common sources of network errors. If you
cannot resolve problems using these procedures, contact your network administrator.

Basic Requirements
Fulfill the following requirements before troubleshooting your host machines:

B Configure your system for use on your network. Contact your network administrator for details. The MTS4000 NICs are
set to DHCP for auto address setup.

B Ensure that any applications that you may have loaded on your test system since receiving it are not using the ports
assigned to the test system components.
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IP Parameters

Installation

The illustrations in this section show how each IP parameter (IP address, subnet mask, and default gateway) can negatively

affect network connectivity.

Incorrect IP address. |If the IP address for your test system is incorrect (not unique), then you may not be able to
communicate over the network. In the next figure, TVTest_1 uses the same IP address as Rennes. If Rennes is started first,
TVTest_1 will recognize the IP address conflict and will not load TCP/IP; consequently, the system cannot be reached over

the network.

If your IP address is incorrect, and the IP address does not exist on your subnet, you may be able to communicate from the
device (system or monitoring station), but you may not be able to communicate to the device.

L ]

]

Tast systam
Rennes

Tast system
TWTest 2

Test system
WTest 1

T

!

NoTCRIF _T

= communicatian

|F address: 128.181.99.62 IF address: 128.193.92.2 IF address: 128.181.99.62

Incorrect subnet mask. Subnets and subnetting networks are complex and require a thorough understanding of IP
addressing. Call your network administrator if you think your networking problem involves subnets. The next figure shows a
simple (and fairly common) subnet mask problem.

MTS4000 and MTS4SA Quick Start User Manual
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In the figure, the subnet mask for TVTest_1 indicates that the network address is contained in the first two bytes of the IP
address. In dotted decimal notation, the network address is 128.181. This information allows the device to communicate with
any other device with the same network address without being routed through a default gateway.

Subnet mask: 255255 255.0
IP address: 128.181.96.201

Test system:; Mo TCRIP
Rt L — !
ar Carnac communication

Test system: Test systam: Test systam:
Rennes TWTest 2 TWTest_1
IF address: 128.181.99.82 IF address: 128.181.99.72 IF address: 128.181.99.62

Subnet mask: 255.255.255.0 Subnet mask: 255 255 255.0 Subnet mask: 255 255.0.0

TVTest_1 cannot communicate with Carnac, because, according to the subnet mask on TVTest_1, Carnac and TVTest_1 are
logically on the same network. Consequently, messages sent from TVTest_1 to Carnac are never routed. Because these
two devices do not share a connection, TVTest_1 will never find the correct address for the network card on Carnac and

will not be able to reach Carnac.

TVTest_1 can communicate with TVTest_2 and Rennes because these three devices share a connection, so messages from
TVTest_1 do not need to be routed. TVTest_1 is therefore able to find the correct addresses for TVTest_2 and Rennes
in spite of having an incorrect subnet mask.
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Incorrect default gateway IP address.

The default gateway you have specified in the TCP/IP Properties dialog box is the device that "knows about" your subnetwork
and others on your network. When you send messages (for instance, traps from your system to a device on another
subnet), the default gateway is able to route the message to the appropriate subnet. If the IP address specified in the
TCP/IP Properties dialog box is incorrect, messages to devices on other subnets will not reach their destination (because
they never made it to the default gateway).

IP address: 128.181.86.201
Subnet mask: 256.255.255.0
Default Gateway: 128.181.96.1

Test system:
IP address: 128.181.96.1 Carnac
Gateway
{router)
IF address: 128.181.96.1
Galeway E:-igdz
te
{router) Metwiork
T
|_ ________ Mo TCRIP _
communication 1
[ 1 i L]
Test systam: Tast systam: Tast system:
Rennes TWTest_2 TWTesi_1
IP address: 128.181.99.82 IFP address: 128.181.99.72 IP address: 128.181.99.62
Subnet mask: 255.255.255.0 Subnet mask: 255.255.255.0 Subnet mask: 255.255.0.0
Default gateway: 125.181.991 Default gateway: 128.181.99.1 Default gateway: 128.181.99.10

Common Troubleshooting Procedures
Many of the procedures performed in the following sections are common tasks.
Pinging a host machine. One of the utilities provided with all TCP/IP installations is ping.exe. This utility allows you

to send communication packets to and record the response from a host machine. This determines whether your packets
arrived at the destination.

NOTE. The ping utility will not work with the MTS4000 unless the Windows firewall is disabled.
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18

To run ping, use the following procedure:
1. Press these two keys simultaneously:

= Windows key (48) + R
This displays the Run dialog screen.

2. Type one of the following into the Run
text box:

B ping Machine_Name

B ping IP_address

In the example, Machine_Name and
IP_address represent the host machine
name and IP address, respectively, of the
networked device you are trying to ping.

3. Click OK.
A DOS window indicates whether or not
the machine is responding to the ping.

Ping only runs briefly and the DOS
window closes when the process is
complete.

CITEE x|

=== Typethe name of a program, folder, document, or Internet
resource, and Windows will open it for you,

Open: |

% This task will be created with administrative privileges,

QK I Cancel Browse... |

M c\wmpDows\system32\ping.exe

Pinging ewel26646 .Central.tektronix.net [134.62.81.1821 with 32 hytes of data:t u
2 time<ims TTL=125 .

.81, : 2 time<{ims TIL=125

Reply from 134.62.81.182: by 2 time{ims TIL=125
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Tracing the route of TCP/IP packets.

Sometimes it is helpful to know how far your packets made it on the way to a destination machine and which devices the packets
pass through on the way. The utility that provides this functionality is tracert.exe. Tracert can also indicate a congested point
in the network. To run tracert, use the following procedure:

1. Press these two keys simultaneously: _ ﬂ

)/
= Windows key (#&) + R

This displays the Run dialog screen ——=  Typethe name of a program, folder, document, or Internet
' resource, and Windows will open it for you.

2. Type one of the following into the Run

text box: Open: I |

B tracert Machine_Name % This task will be created with administrative privileges,

m fracert IP_address

In the example, Machine_Name and oK I Cancel Browse... |

IP_address represent the host machine
name and IP address, respectively, of
the networked device you are trying to

reach.
3. Click OK. N C:\WINDOWS\system32\tracert.exe
A DOS window indicates the progress [racing route to ewe126646.Centrnl.tektronix.net [134.62.81.1021
. over a maximum o hops =
pf YOUI’ packets. The far right column <1 ms <1 ms rs3923a—vlan.dhrtn.net [134.62.86.1]
indicates the IP address of the nodes DA R GR RnIN dennes 1134.62.64.1291

on the network that successfully pass
your tracert packets. This information
indicates the last good node on the path
to the destination device.
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Finding IP addresses for devices on your network.

At times, you may need to find or confirm the IP address of a computer on your network (or find the network name if all you have is
an IP address). You may want to find this information to ensure that IP addresses and network names you use in the Hosts file are
correct. The utility nslookup.exe displays this information.

1. Press these two keys simultaneously: _ ﬂ
= Windows key (4&) + R

This displays the Run dialog screen === Typethe name of a program, folder, document, or Internet

resource, and Windows will open it for you.

2. Type one of the following into the Run
text box: Open: | nslookup ewel126646] =]

% This task will be created with administrative privileges.

B nslookup Machine_Name

® nslookup IP_address

Machine_Name or IP_Address is the network oK I Cancel Browse... |
name or IP address, respectively, of the
device you are trying to look up.

3- C“Ck OK =+ C:\WINDOWS\system32\cmd.exe

The network name and IP address of the e o e bt Hionsoit bom.
device you are trying to look up is displayed. o e S R
If your network uses DNS, the IP address pddress:  192.158.201.15

and network name of the DNS server is also None s o ot con tah can

displayed Address: 128.181.39.88

ConD

NOTE. Using nslookup from the Run
command may not provide enough time to
review the results. You may want to use
a Command Prompt window from Start >
All Programs > Accessories > Command
Prompt.

Sources of Network Information
If you need more information about network troubleshooting, some potential resources are listed below.
®m  Cisco Systems, Inc. — http://www.cisco.com/

This site is particularly useful for networks that use Cisco devices.

B Dulaney, E; Lawrence, S; Scrimger, R; Tilke, A; White, J; Williams, R; Wolford, K. MCSE Training Guide: TCP/IP.
Indianapolis, IN. New Riders, 1998

This is a training guide for Microsoft Certified Systems Engineer certification, and covers TCP/IP and network
troubleshooting.

B Taylor, E. Network Troubleshooting Handbook. New York, NY. McGraw-Hill, 1999

NOTE. These resources may provide you with more information. Most of this information is supplied as is, with no warranty
as to its fitness, written or implied. The best source of network troubleshooting help is your network administrator.
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Operation

Product Description

The MTS4000 MPEG Test System provides a comprehensive and integrated suite of real-time and deferred (offline) analysis
tools. The tools include TS (transport stream) compliance, buffer, PES, MPEG2, and MPEG4 video and audio elementary
stream analyzers. Also included are an editor and a multiplexer to create stream content, and test and error-stressing
streams.

The applications in the MTS4000 analysis toolset are targeted at a specific aspect or layer of a transport stream. The
following figure illustrates this principle in simplified form.

Elementary i
Stream Analyzer -
\*{ Audic ]
\[ Ancillary Data J

PES
PES Analyzer »  (Packetized Elementary

Stream)
Presentation Decoding
|4 Time Stamp Time Stamp

Carousel Analyzer
Buffer Analyzer [ Data ]<— and

Carousel Generator

[

' Pal
: {Program Specific Information - MPEG)

5l
| (Senice Information-DVB) |
| PSIP |
| {Program and System Information |

Protocaol - ATSC) |
r——=——77 PcR I S
| (Program Clock Reference) r-— Transport Stream
PSR gt A i Analyzer

Transpart Stream /

The Procedure section tells you how to start the application, how to analyze a test stream, and what results are presented.
The procedures do not tell you how to interpret the results.

Standards compliance is ensured though built-in customizable scripting, which supports a broad range of ratified and
evolving DTV standards. New standards and proprietary tables can easily be implemented by loading Tektronix supplied
updates, or creating your own custom scripts.
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Software Applications

This section provides an overview of the software applications that make up the MTS4000 MPEG Test Systems. Note that
some options might not be enabled. Detailed descriptions of all applications can be found in the MTS4000 system MPEG
Test System applications user manuals.

Desktop
Application Icon

Analyzers

Transport Stream Compliance Analyzer (TSCA) — Real-time and Deferred time transport stream analysis
with user-selectable MPEG-2, DVB, and ATSC conformance tests. Shows transport structure, header
contents, hexadecimal packet contents, PCR timing /transport rate graphs and error message logs.

The first RF/IP card installed in the MTS4000 Test System is installed above the ASI card. This & !

RF/IP card is accessed using the TS Compliance Analyser icon located on the desktop and in
the Start menu. %
TS
Compliance
Analyser

RF/IP card accessed using the TS Compliance Analyser P1 icon located on the desktop. (There is

The second RF/IP card installed in the MTS4000 Test System is installed below the ASI card. This E
not a TSCA P1 icon in the Start menu.) 5

L1

TS
Compliance
Analyzer P1

Packetized Elementary Stream (PES) Analyzer — PES analysis with selectable test options. Shows PES
program structure, header contents, packet contents, PTS/DTS timing graphs and analysis reports.

PES Analyser

Transport Stream — System Target Decoder (T-STD) Buffer Analyzer analyzes program streams modeling
their behavior in, and their conformance to, the MPEG-2 T-STD Buffer Model. Includes a trace facility. 5
Buffer
Analyser

Elementary Stream — Analyzer Elementary Stream analysis at video picture and audio level. This
includes vector graphs and macroblock picture quality.

ES Analyser

Carousel Analyzer — Data analysis showing structure, bit rate, repetition rate, syntax and semantics of

data items. g
Carousel
Analyser
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Application

Operation

Desktop
Icon

Generators

Carousel Generator — Provides in-depth, off-line generation of MPEG-2, DVB transport streams
containing a range of data broadcast protocols.

%.’1

Carousel
Generatar

Multiplexer — Multiplexes table information and packetized elementary streams together to synthesize
new transport streams. A fine level of control is provided to allow nonconformances and test cases to be
specified for new transport streams.

&

Mulkiplexer

TS Editor — Viewing and editing of transport stream packets, using a hexadecimal view of the packet
contents and semantic interpretation of the header. Provides facilities to remap PIDs, recalculate PCR
values and introduce PCR inaccuracies.

™

Players

MPEG Player — Plays MPEG-2 transport streams.

MPE(S Player
Utilities
Make Seamless Wizard — Guides the user through the process of creating an MPEG-2 transport stream
file for use by Stream Player in continuously looped operation. =
Make
Seamless

Stream Cutter — Extracts sections of MPEG-2 transport stream files to new files.

Script Pad — Enables users to create and modify System Information (SI) scripts.

TTS Utility — Converts time stamped transport streams to standard transport stream format.

2
S
=

1 Ifinstalled and licensed.
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Operation

Starting an Application

All applications are started from the desktop shortcuts or from Start > All Programs > Tektronix MTS4000 menus.

The MTS4000 system application user manuals provide full descriptions of all applications. The following table shows the
hierarchy of applications in the Start menu.

Menu hierarchy

Tektronix MTS4000 > OptionKey Wizard

Analyzers > Buffer Analyzer

Carousel Analyzer

ES Analyzer

PES Analyzer

TS Compliance Analyzer

Generators > Carousel Generator

Multiplexer

TS Editor

Player > MPEG Player

Utilities > Make Seamless Wizard

ScriptPad

Stream Cutter

TTS Utility

NOTE. Even though all applications are shown in the Start menu, you can only open those options that have been
purchased and licensed.
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Operation

Duplex Operation

The MTS4000 system can be operated in duplex mode (ASI or IP only). For example, while the Player is playing out a
stream, the Transport Stream Compliance Analyzer (TSCA) can be analyzing a separate stream or, if the output is looped
back to the input, the output of the Player can be monitored by the TSCA.

Setting Up Loopback
With loopback in operation you can:
®  Use the MPEG Player to play out a stream

®m | oop the instrument output back to the input (For example, with the ASI card, loop ASI-4 back to ASI-3. With the 10G
card, loop the output back to the input using an LC multimode jumper cable.)

B Monitor/analyze the incoming stream using the TSCA
Before starting:
B |dentify the stream to be played out (in this example, the sym1.mpg test stream is used).
= Choose the output/input interface (ASI) and make the necessary connections (loop between the connectors).

In the following example, the stream is looped back using the ASlI interface and the stream is looped in the player (to
play continuously).

MPEG Player setup.
1. Open the MPEG Player: Start > All Programs > Tektronix MTS4000 > Player > MPEG Player.
2. Open a stream: File > Open... > Sym1.mpg.

NOTE. The Sym1.mpq file is provided for use to help understand the MTS4000 applications. The file is available in
several locations such as the hard drive of the MTS4000 (c:\TestStreams), the Tclips MPEG Test Streams DVD, and
the Documentation Browser CD.

3. Make the following settings in the Play menu:
Packet size: 188
Update: On
Sync: TS Packet
Loop: On
Other: Standard: DVB

TSCA setup.
1. Open the TSCA: Start > All Programs > Tektronix MTS4000 > Analyzers > TS Compliance Analyzer.

2. In the start-up dialog box (Open Transport Stream...), select Change... in Stream Interpretation and select the DVB
base standard with no extensions. Close the Stream Interpretation dialog box.

3. Select Real-time Analysis and select ASI from the Interfaces drop-down list.

4. Select OK.
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Operation

Start the playout and analysis.

1. Return to the MPEG Player window and play the stream by selecting: Play > Start/Stop or use the toolbar button.
2. In the Player window, note that the status bar is now displayed and that playout has started.

3. Return to the TSCA window and note that analysis has started.

The MPEG Player is now playing out the sym1.mpg transport stream and, through the ASI input and output on the instrument
connector panel, the TSCA is monitoring and analyzing the stream.

For detailed descriptions of the MPEG Player and the TSCA, refer to the MTS4000 Analyzer Applications User Manual.
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Procedures

Procedures

Using the Multiplexer

The following application example describes using the Multiplexer to create a new transport stream and add elementary
streams to the transport stream.

The new transport stream created with this procedure (named TestMux.mpg) is used to complete some of the additional
procedures in this manual.

Create a New Stream Using the Multiplexer

In this section of the application example, you will create a new transport stream using the MTS4000 Multiplexer application. You
will introduce one error so that you will be able to observe it in a later section of the application example.

1. Open the Multiplexer application. Start > :
All Programs > Tektronix MTS4000 > E wlElE ] 20| #lmswlnle[BalE] | slar
Generators > Multiplexer.

2. Select View > Interpretation.

Stream Interpretation

3. In the Stream Interpretation dialog box, [ Standard Setting Dats Standards
ensure that the selected Base Standard Base Standacd [5VE ] I~ ATSC 50
is DVB and that the Region is None. L L
Region INone LI
4. Select OK to close the Stream
Interpretation dialog box. o
'E)"'\ﬁ'ggcspcp Q Reload Scripts |
2| B
* x|
Elﬁl Cancel |
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8.

Select File > New.

In the Navigator window, highlight the
Transport Stream node and select
Properties from the context menu.

In the Stream Properties dialog box,
enter a bit rate of 24.128 Mbit/s
and a fixed duration of two minutes
(120 seconds). Select OK.

Note that the two values are displayed in
the status bar.

In the Navigator window, highlight the
Transport Stream node and select Add
from the context menu.

= Navigator: Untitled

Stream Properties

Bit rate: |24.1 28 b bit s
Duration
(¥ Fived: |1 20 %

" Set to greatest component stop time

Cancel

Filter OFF DVE TS Rate 24, 128Mbitfs  Duration 120s Standard Ready

= Navigator: Untitled

Properties
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9. In the Transport Stream Settings dialog
box, enter 1 as the Transport Stream
identity.

10. Select the PAT (Program Allocation
Table) folder icon button to open the PAT
Timing dialog box.

In the Version Timing tab window, note
that the PAT timing Start time (0 s) and
Stop time (120 s) mean that the PAT will
be transmitted for the stream duration.

11. Select OK to close the PAT Timing dialog
box.

12. In the Transport Stream Settings dialog
box, select Next.

13. In the Optional Tables for the Stream
dialog box, select the TDT (Time and
Date Table) check box and select the
TDT folder icon button.

MTS4000 and MTS4SA Quick Start User Manual
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= Navigator: Untitled

i '1! Programs [Stream Id 0 Yersion 0]

Transport Stream Settings

1‘ Transport Stream Transport Stream: {1

2 PAT Section

Version Number: |0

< Back Mext > Cancel | —

Programs Pids

= Navigator: Untitled

Transport StreamSettings ________________|x]

I Transport Stream Transport Stream: [{
@D PAT Section
Version Number: |0

_; Transpu
!-! Prod

PAT Timing

Version Timing | Subtable Timing |

Start Time: ID E
Signalled As Cumrert Time ID s
Stop Time: I 120 &

¥ Transmit until end of transport stream

e

Programs | Tables | Fids

ptional Tables for the Stream

b Transport Stream Select Optional tables for the stream:

~[ED PAT Section I~ Network Information Table (NIT)

~@&B TDT Section
Nt Setings |

I~ Time Offset Table (TOT)

o |

¥ Time and Date Table (TDT)

10T

< Back Nexd > Cancel

Programs | Tables | Fids
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In the TDT Timing dialog box, confirm
that the Start Time is zero and the
Stop Time is the same as the duration
previously set.

Note that the duration may have been
adjusted by an insignificant amount. In
this example, the set duration of 120 s is
now displayed as 119.999976127.

14. Enter a Cycle Time of 1000 ms.

15. Select OK to close the TDT Timing
dialog box.

16. In the Optional Tables for the Stream
dialog box, select the NIT (Network
Information Table) check box and select
the NIT Settings button.

17. In the Set up the NIT dialog box, enter
the Network Id 1234 and the Network
Name Tek_test.

18. Set the Original Network identity to 2
and select Terrestrial from the Delivery
System drop-down list.

19. Select the Delivery System Settings
button.

» Navigator: Untitled

am|
E Programs [Stream |d 1 Yersion 0]

Optional Tables for the Stream

1 Transport Stream Select Optional tables
- @ PAT Sectiog "
= RIOREEE TDT Timing

forthe stream:

Section Timing |

Start Time:

Stop Time:

Cycle Time:

Max cycle time recommended by standard: 30000 ms

Cancel | Aoply

Programs Fids

= Navigator: Untitled

i Programs [Stieam |d

Programs Pids

1 Wersion 0]

Optional Tables for the Stream

b Transport Stream Select Optional tables for the stream:
~~ED PAT Section ¥ Network Information Table (NIT)
@B TDT Section i

@ NIT Section T EI
I Time Offset Table (TOT)
wr |
v Time and Date Table (TDT)
wr 13 |
< Back Next > Cancel =

= Navigator: Untitled

E. Transport Stesam il
£ Set up the Nit
: NIT S version: 0
Metwork I [1234 ~|
Metwork Mame: |Tl3k_ll38t
Transport Stream
Original Metwark 1d |2
Delivery System Tenestnal =
Programs Pids -
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20.

21.

22,

23.

In the Terrestrial Settings dialog box,
enter 0x123456 in the Centre Frequency
field.

Select 2 (64-QAM) from the Constellation
drop-down list.

Select 4 (non-hierarchical, in-depth
interleaver) from the Hierarchy
Information drop-down list.

Select 1 (8k mode) from the

= Navigator: Untitled

Procedures

Be Programs [Stream 1d 1 Version 0)

Optional Tables for the Stream

Terrestrial Settings

Centre Frequency(,1 23456

Constellation

2 (B4-04M)

oo

Bandwidth IU [8 MHz] -
Hierarchy Info |4 [hor-hisrarchical, indep «

Code Rat
’7HF' Shieam IU [1/2) i LP Stream lU 1421 'i
I}

Transmission Mode drop-down
list.

24. Select OK to close the Terrestrial
Settings dialog box.

25. Select OK to close the Set up the NIT
dialog box.

26. In the Optional Tables for the Stream
dialog box, select Next to display the
Transport Wizard Complete dialog box.

The transport stream set up is complete.

Now you need to add some content in the

form of video and audio elementary streams.

Do not close the Transport Wizard Complete

screen.

MTS4000 and MTS4SA Quick Start User Manual

Guard Interval IU 1432 S T oM o |1 [8k mode] A

Other Frequency Flag ID [no other frequency in use) ;I

Cancel

Programs | Tables | Pids

B4 renopor Sreor]

g Programs [Strear |d 1 Version 0]

Transport Wizard Complete

3{‘ Transport Stream
~{@D PAT Transport Stream Id 1 [(c1] Version 0 Section 0 [Pid 0 {(x0)]
&) TDT[Fid 20 [@14]
- NIT_actual Network ID 1234 Version 0 Section 0 [Pid 16 (Qx10)]

11 ]

Transport Wizard Complete. Add a Program Wizard W

< Back Cancel

Pragrams o

31



Procedures

32

Elementary Stream Acquisition.

For this example, you need to add a video and an audio elementary stream to the transport stream that you have created. You
can extract suitable streams from one of the sample transport streams supplied with the MTS4000 installation. The stream
used in this example is Sym1.mpg. This file is available on the hard drive of the MTS4000, the Tclips MPEG Test Streams

DVD, and the Documentation CD.

1. Open a second instance of the
multiplexer. Start > All Programs >
Tektronix MTS4000 > Generators >
Multiplexer.

2. Select File > Open.

3. Inthe Set MPEG File to Edit dialog box,
locate and open sym1.mpg.

4. Expand the program 1 node and the
dependent Elementary Streams node.

5. Highlight the PID 110 node. This PID is
carrying an MPEG-2 video elementary
stream.

6. Select Export Elementary Stream in
the context menu.

7. In the Save As dialog box, enter a file
name (Sym1pid110.es) and save the file
to a suitable location.

8. Repeat the action for PID120. Name the
file Sym1pid120.es.

9. Select File > Exit to close this instance
of the Multiplexer.

This completes the extraction of the video

and audio elementary streams. You can

continue with the multiplexing task.

-
e ve )
S|@ so| (] B8] | | o8| @] x 2 (R[22 ] (| =@ e

= Navigator: C:\Streams\Sym\Sym1.mpg

S Transpart Stream

.E.!gg Programs [(Stream |d 1 Version 0)

Eta 1 édherent | [dherent Systems]

H Service Sections

A Event Sections

Elementary Streams [FMT Yersion 0]

a 2 Adherent Il [Adherent Sypstems]
B 3 Adherent Il [Adherent Spstems]
E 4 ddherent IV [Adherent Spsterns]
=] 5 AdherentV [Adherent Systems]

o JPid 110 Stream type: 2 (0x02) (MPEG-2 Vigges
- J3 Pid 130 Stream type: 4 (0x04] [MPEG-2 A
J3 Fid 120 Stream type: 4 (0x04] [MPEG-2 &

Delete
Cut

Copy
Paste

Export Payload...
Export Elementary Stream...

Properties

Programs | Tables | Fids
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Add Elementary Streams.

Now you can return to the original multiplexer instance and add the elementary streams that you have just created.

1. Ensure that Add a Program Wizard is
checked and select Next.

2. Inthe Add a Program dialog box, enter
1 as the program number.

3. Select the PMT folder icon.

4. Inthe PMT Timing dialog box, select the
Subtable Timing tab.
The subtable timing cycle time is the
period over which a table is repeated in
the stream. The maximum cycle time for
the PMT in the DVB standard is 500 ms.

5. For this example stream, set the cycle
time to 525 ms.

6. Select OK to close the PMT Timing
dialog box.

7. Inthe Add a Program dialog box, select
Next.

MTS4000 and MTS4SA Quick Start User Manual
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Transport Wizard Complete

I‘ Transport Stream
PAT Transport Stream Id 1 [«1] Version 0 Section 0 [Pid 0 {&x0)]
TOT [Fid 20 (14}
@) NIT_actual Network 1D 1234 Version 0 Section 0 [Pid 16 (G 10)]

@ I3

Transpert Wizard Complete. Add a Program Wizard W'

< Back

Cancel

Programs [

= Navigator: Untitled

lu rograms [Steeam Id 1 Yersion 0]

Add A Program

SE Transport Stream
Bl PAT Section
B TDT Section
NIT Section
B Program

E PMT Section

Settings for Program

Program number; |1
Version number: |0
Program map PID; |32

PMT

< Back

Cancel

Programs - Pids I

= Navigator: Untitled

,,J! Frograms (5 tream Id 1 Wersion 0)

Add A Program

525 ms

Mazx cycle time recommended by standard: 500 ms

Cycle Time:

Programs Pids
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10.

1.

12.

13.

14.

15.
16.

17.

In the Add Service Description dialog
box, select the Add Service Description
check box.

Enter a Service Provider Name, for
example, Tek Broadcasting.

Enter a Service Name, for example,
Tek1.

Enter a Service Type, for example, 1
(0x1) (digital television service).

Select Next.

In the Add the Program Content
dialog box, select Add to add a video
elementary stream.

In the Add Program Stream dialog box,
select 2 (0x02) (MPEG-2 Video) from the
Stream Type drop-down list.

Ensure that the Source tab is selected.

Enter a File Name, or use Browse to
locate the video elementary stream
previously set up (Sym1pid110.es).

Select MPEG-2 video from the File type
drop-down list. Note that the file bit rate
has been entered automatically.

= MNavigator: Untitled

f Progiams [Stn

bl Add Service Description

1 Transport Stream
PAT Section
~ED TDT Section

Add Service Description [+
Use Single Section -

NIT Section Service Provider Name:
Program ITek Broadcasting

~ED PMT Section
SDT Section

Service Name:

[Tek 1

Service Type:

|1 (T« 1) {digital television service) j

so1 3|

< Back

Programs | Tables | Pids

+ Navigator: Untitled

BRIl 4 id the Program Content |z|

1 Transport Stream
PAT Section
~EB TOT Section
~@EB NIT Section
&) Program
~EB PMT Section
~EB SDT Section

Set

Dekte | Update |

3
Streams added so far:

Pid Type Filename

I~
|

< Back Nets | Cancel

Programs | Tables | Pids

= Navigator:

R e /i the Program Content

Add Program Stream
"' Transport Stred

“ED PATSectf  Sieam Type 2 [0402) IMPEG -2 Video) ~|
BB TDT Sect
NIT Sectid  Pid Number: |33
Program
PMT Sec  Source | Timing | FCR |
BB 5SDT Sect
File name: IC MStreamshSym \Sym 1pid110.es Browse...
Fletype: [MPEG 2 video | Bimte: [5000 kb
Original TS PID: I Extra DTS offset: |0 s
Stream_id ID Start each figld in a new pes packet [

[~ ComponentTag |1 Cancel |

Programs | Tables | Pids
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Select the Timing tab. Note that the > Navigator: Unitied
elementary stream is going to run for the
length of the stream previously set, that BB i the Program Content
iS, 120 S. Add Program Stream
.: Transport Stred
i PAT Seclf  Sheam Type |2 (0402] (MPEG -2 Video) ~|
TOT Sect,
NIT Secti Fid Number: l33—
B Program
@D FMTSect]  soue Timing | PCR |
“[ED SOT Sect]
Start time: |0.0020000000949949 5
Stop time: [119.999576127321 s
Loop interval: |0 s ¥ Loop
[~ ComponentTag Il]
Pragrams | Tables | Pids
18. Select the PCR tab. Ensure that the T E——
Carry PCR check box is selected. e

e Programs [Steam |d Add the Program Content

Add Program Stream

AL Transport Stred
-E PAT Sedt Stream Type |2 [0402) [MPEG-2 Viden) ;I
TOT Sect]

D NIT Sectid  Pid Mumber: |33

Program
PMTSec  Source | Timing PCR |

@D SDT Sec
chaw PCR Set Defaulis PCRPID: 8191

Initial PCR: PCR Interval: [36 ms

I~ Preserve PCR Inaccuracy I™ Preserve PCA intervals

[~ ComponentTag |/ Cancel

Pragrams | Tables | Pids

19. Select OK to close the Add Program
Stream dialog box.

8-} F'rugras [ Add the Program Content
20. In the Add the Program Content dialog ALl e
H H S, Transport Stream
blox, seltect Atdd again to add an audio -- e i AR —
elementary stream. D TDT Section
“-ED NIT Section id Number: |34
3 = gmm o Hatn
21. Select 3 (0x03) (MPEG-1 Augllo) from oty Souee | Tming | PCR |
the Stream Type drop-down list. =D Actve PIDs Fie nome: [C7Greams Sy Sy md 12023 e
-l Pid: 33 Type: 3
. Flle type: |MPEG-2 audio | Bimte: |- kb/s
22. In the Add Program Stream dialog box, I !
. Original TS PID: | Extra DTS offset: |0 s
ensure that the Source tab is selected. <1
Stream_id ID Gtart each section ina new packet [T
23. Enter a File Name, or use the
Browse button to locate the audio (et e [ =
elementary stream previously set up Frogams | Tabes | P

(Sym1pid120.es).

MTS4000 and MTS4SA Quick Start User Manual 35



Procedures

36

24,

25.

26.

27.

28.

29.

30.

3.

32,

Select MPEG-2 audio from the File type
drop-down list. Note that the file bit rate
has been entered automatically.

Select the Timing tab. Note that the
elementary stream is going to run for the
length of the stream previously set, that
is, 120 s.

Select the PCR tab. Ensure that the
Carry PCR check box is cleared.

Enter 33 in the PCR PID field. This is the
PID that will carry the PCR information —
also the video es, Carry PCR.

Select OK to close the Add Program
Stream dialog box.

Select Next.

In the Event Information dialog box,
select the Event Information Tables (EIT)
check box.

Ensure that the Present check box is
selected.

Select Present Settings.

Add Program Stream

Stream Type |3 (0x03) (MPEG-1 Audio) |

Fid Mumber: |34

.SourceITiming PCR |

St Defaults |

Initial PCR: IC

™| Bresenve PCR Inaccuracy

PCR FID: |33
PCR Interval: IEE ms

™| Fresenve PLR intenvals

[~ ComponentTag ID | oK I Cancel

Event Information

Add event information

ﬁt. Transport Stream

i-[E) PAT Section

i[@ TDT Section

“.[@) NIT Section
) Frogram

i[E) PMT Section

. SDT Section

mgl Event Information
BT Active PIDs
«d Pid: 33 Type: 2 (x(
i J1 Pid: 34 Type: 3 (Ix(

[« | [

Event Information Tables (EITE [V

Present [V EI Settings |
Following W EI Settings |

< Back Cancel
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33.

34.

35.

36.

37.

38.

39.
40.

41.

42.

43.

44,

45.

46.

In the Present Events dialog box,
select Add to set up the present event
information, that is, the time of this
broadcast. In the Event dialog box,
select 4 (running) from the Status
drop-down list.

Set the Start Time to 2008-08-28
10:20:00 AM.

You can change the time and date

by highlighting the individual field and
entering the required value.

Enter an Event Name, for example, Tek
World.

Enter a Description, for example, The
future of Tek.

Enter a Duration, for example, 30m
(00:30:00).

Select 257 (MPEG-2 video, 4:3 aspect
ratio, ...) from the Content/Component
Type drop-down list.

Select OK to close the Event dialog box.

Select OK to close the Present Events
dialog box.

Ensure that the Following check box is
selected.

Select Following Settings.

Select Add to set up the following event
information, that is, the event following
the present event.

In the Event dialog box, enter 1 in the
Event Id field.

Select 1 (not running) from the Status
drop-down list.

Set the Start Time to 2008-08-28
10:50:00 AM.
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Present Events

EventId |D Status |4 [runring] ;I

Ewent | Mame

Start Time: |EDDS—DS—28 10:20000 Ak .ll

Event Name |Tek wrld Duration  |00:30:00 ‘iJI

Description |The future of Tek,

Content/
Companent Type

Stream ltem [Tagl |0 Select Tag

IZST [MPEG-2 video, 4:3 aspect ratio, ...] j

Stream Description |

Programs Tahles!F’ids I

e Cancel

Navigator: Untitled

_: Transrnst Cirasmd
- Event Information

A5 Transport Stream
+-[EB PAT Section

- TDT Section
@) NIT Section

ﬂ Program

" @D PMT Section
@D SDT Section

& Event Information
E--fﬁ Active PIDs

e i

ot Pid: 33 Type: 2 (I
7 Pid: 34 Type: 3 {0

El

Add event information

Event Information Tables (EIT) W

Presert |V E_l Settings l
Following ¥ _EQJ Settings I

< Back Cancel

Programs | Tables | Pids
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47.

48.

49,

50.

51.
52,

53.

54,

Enter an Event Name, for example, Tek
News.

Enter a Description of the event, for
example, All the latest news from Tek.

Enter a Duration, for example, 30 m
(01:00:00).

Select 257 (MPEG-2 video, 4:3 aspect
ratio, ...) from the Content/Component
Type drop-down list.

Select OK to close the Event dialog box.

Select OK to close the Following Events
dialog box.

Select Next in the Event Information
dialog screen.

In the Program Complete dialog box,
select Finish.

¥ Program Complete

Press finish to add the new program
5[. Transport Stream
PAT Transport Stream Id 1 [(¢1] Version D Section 0 [Pid 0 (Qx0)]
: TOT[Fid 20 (k4]

: NIT_actual Network ID 1234 Version 0 Section 0 [Fid 16 (T10)]
) Program

PMT Program 1 [(0001] Version 0 Section 0 [Pid 32 {(20)]
SDT _actual Transport Stream [D 1 Version 0 Section 0 [Pid 17 (0

Event Information
=14 Active PIDs
uiif Pid: 33 Type: 2 (1x02) (MPEG-2 Video) File: C:\Streams\Sym"\Sym
- J) Pid: 34 Type: 3 (103) (MPEG-1 Audio) File: C:\Streams"\Sym".Sym
< | *

< Back Cancel

Programs lTah\es; Pids
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You have finished creating the structure
and content of the proposed transport
stream. You can now make a couple of
checks to ensure that the stream will compile

'rograms [Steeam |d 1 Version 0]

= Available Bitrate (@MGB2): Untitled

successfully. —
39.20 » Hbps
55. Select View > Available Bitrate. 22T | i :
In the Available Bitrate graph, note that R
the bit rate remains within the required 20608Mp5 | 0y
bitrate, that is, 124.128 Mbps. Refresn | 1000
You can examine the bit rate at any point %

on the graph, by clicking a point and
reading the values from the adjacent
table.

Programs

56. Close the Available Bitrate graph.

0.000Mbps
0 05 120.00¢

Showing: |0.00 : |119.9¢ Cument: |39.20 ]ﬁ ﬁ:

57. Select Multiplex > Start to start the
multiplex.

58. In the Set TS Output File... dialog box, x

enter the name TestMux.mpg for the Sovern [ MTséo00ves s BRI =
new multiplexed transport stream. (This
new transport stream is used in other
procedures.)

Watch the right side of the Status bar for
the multiplexing progress; the progress
bar may be hidden if the window is too
small horizontally.

The elementary streams and structural
information have now been multiplexed
together to form the transport stream,

TestMux.mpg.
59. Itis a good idea to save the structure of fegme I = Save
the multiplex, so that it can be recalled Saveastpe: | MPEG Fies ("mpg "t} = Canedl

and more information added to it as
required.

MTS4000 and MTS4SA Quick Start User Manual 39



Procedures

40

60.
61.

62.

Select File > Export....

In the Export File dialog box, enter a
name for the multiplex structure file, for
example, TestMux.muxml and select a
location to save the file. Note the muxml
extension.

Using File > Import, the multiplex
structure file can be reopened at any
time to add elementary streams or
structural information.

= Tektronix Multiplexer

File View Options Window Help

Mew Cirl-+M
Open... Ctrl+0
Examine TS Cirl+T
Close

Expart... Chrl+E
Expaork s, ..

1 C:\Jsersh, .. \TestMu. muxml

Exit
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Using the Transport Stream Compliance Analyzer

The following procedure examines a transport stream off-line using the File Analysis mode of the Transport Stream
Compliance Analyzer (TSCA). The procedure uses the transport stream (TestMux.mpg) created in the Using the Multiplexer

procedure.

Use the Real-time Analysis to analyze live data. (See page 59, Multiple Input Monitoring.)

1. Open Transport Stream Compliance
Analyzer. File > Program >
Tektronix MTS4000 > Analyzers
> TS Compliance Analyzer.

The Open File Analysis dialog box
displays automatically. If not, select File
Analysis in the TSCA Analysis toolbar.

In the Open File Analysis dialog box,
ensure that the Base Standard is DVB
and the Region is No Extensions.

2. Locate and select the example stream,
TestMux.mpg.

Ensure that in the Advanced Settings pane,
the Stream Bit Rate and the Timestamp
Settings are as shown.

MTS4000 and MTS4SA Quick Start User Manual

[E¥ No File - MPEG TS Compliance Analyzer

Anslysis View Novi

igst

Procedures

PFH Flexvuplus™ | & Analysis

Programs | Tests | 5/PS1 [ (£ Open File Analysis
Standard
O norar Base Standard DV, R tensions s
Using default scripts. Seripted validations are not enabled, 2
Lookn: [ LocalDisk (c3) - 2 @8 =]
. Acranis DVD o
- Intel —
Recent Items Perflogs
Pragrarn Files
= Programm Fies (xi6)
Tektronix
Deskton
My Documents
Computer
A
& e name:
Hetwork
Fies of type! (PG Transport Sream Fils (*.mpa, *.mpeg, *.trp, .5, ®1ms) +
S o . H
O ts.apmr O 2.4PCR Accuracy O 3.5.2507 Actual L4
O 16D Qzspts O 3.5 DT Other
Ozscar O 3.6.4EI7 Actual
) 3ARFIT Oter 4
75 Availebiiey @)||5ync ()| 0.000000 Mops @ 18 0| (V8 o Extensions )

¥ Open File Analysis

Standard
Loakin:

Waorking,ilcab

Control Panel

L )

My Documents

&

My Recent
Dacuments

Desktop

Standard

@' Open File Analysis

Base Standard DVB, Region No Extensions
Using default scripts, Scripted validations are not enabled.

EE v 2rEE

Base Standard DVB, Region Mo Extensions
Using defaulk scripts. Scripted validations are nok enabled.

&

|Ha] _TestMux.mpg
!lil Symt.mpg

|k stmr.TRR

|iﬂ Sym2.mpg
| sz, TRP

!lil Sym3.mpg

| smz.TRP

|iﬂ Symé.mpg

|k s TRP

!l’ll SymS.mpg

] s, TRR

(2] Symé.meg
SYMB.TS

I{ﬂ tekTestMux.mpg
|E3] TestMux.mpg

Advanced Settings | Favourite Files

Stream Bit Rate

The stream bit rate is used s 2 basis for fiming
measurements during analysis. Plesse select
how the bit rate i calculated:

(5) Presean first |100 |pcrs
() Prescan all PCRs in file
O Marualy st | | Mbps

Timestamp Settings
O T

O Use Rerival Timestamps (Fprasant)
© Use TTS Timestamps (F prasent)
CaptureVu™ Settings =]
[[] Pause analysis at packet index

Flepame:  [TestMux.mpg ]

Fles of type: | PEG Transport Stream Files (*.mpg, *.mpeg, *.trp, *.ts, *.rmx) ¥
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3. The analysis will take a moment to
complete.

4. Select the Analysis tab to display the
navigation and related views.

5. Select the Programs tab and expand the
nodes in the navigation view by clicking
the plus symbols.

In the detail views, ensure that the
Summary view and the Tests view are
displayed.

The Transport Stream node and the
Program node are both red. This shows
that an error has occurred in the stream
and is still active.

6. Highlight the Transport Stream node.
In the Tests Summary detail view, TR
101 290 tab, note that test 1.5.a PMT is
indicating an error, that is, the associated
LED is red.

B Flexvuplus™ | £ Analysis

+¥ File Analysis

Starting analysis...

C:\Streams|Sym| TestMux. mpg

mpliance Analyser

Programs | Tests | siypst | PIDs | Packets

o
Qro3@an @®
QD342 A

24.128 Mbos
iding Nl PID 3.221 Mbps

Show fter @
Name Humber Curen Bt Rate Curent.. | VinMbps) | M) | %

[@fecr  hon  [emw | 328 s s 1s.30%)

Ohucrosoic.| — | e— 202 20602 20916 86.67%|

i
@ 3.0.aNIT Aca
O .16 NIT Other

ity
@usapT2s |Q24PcR Acuan

@ 167D X

s atsity ) smc @ 26

1] 55 o |
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7. Highlight test 1.5.a PMT and select _
View this test in the Tests tree from the

context menu. @ TR 101 290 (230) | (@] Dﬂ"lerl () 5FN Errorl -
* Priority 1 (22
@ 1.15ync Q@ 21T
@ 1.2 5yncByte @ z22a
@ 1.3.aPaAT Q@ 23a
Q) 1.4 Continuity @ 23b
@ 15aPMT = oo
oo T
Edit Parameters. .. I,

Reset

Disable

Enable

Reset All Tests

1,925, 106 Pack Disable All Tests

Enable All Tests

Audible Alarm
CaptureVu™ Breakpoint

Clear All Trigger Actions

View this Test in Tests Tr

The Tests tab views are displayed. The ‘
navigation view is expanded to show the
failed test. The detail view shows any

PIDs associated with the highlighted test

(none in this example) and the event e,
log filtered to show only events for the B3
highlighted test. - S,

‘Q 1.5PUT (Scrambling)

Examine the log entries for error
information. Note that the error reports
refer to a duration of 525 ms. This is
the PMT section repetition rate; 525 ms
was the value set in the example stream
created earlier.

@ informational Everts.

TR 101 290

TR 101 250
TR 101 250
TR 101 250
TR 101 250
TR 101 250
00ts8125 TR 101 290
Oogtss102 (TR 101 290
00057601 TR 101 250 a T
0001:57.577 (TR 101 260 rror 1 5. (U
000157076 |TR 101280 15 (EUT curati L

duration 525ms

15 Avaisbity Q) |Sync @ 23.127999 s @ 158 7 1,525,106 Pakets 0V o Extensions e
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8.

In the navigation view, highlight the
1.5 PMT (Timer) test and select Edit
Parameters from the context menu.

In the Edit Parameters dialog box, note
that for this stream the PMT section
maximum repetition interval is set

to 500 ms. Since the repetition rate
found in this stream exceeds this value
(525 ms), it is being reported as an error.
However, by examining the maximum
and minimum repetition rates shown in
the Edit Parameters dialog box (hover
the mouse pointer over the value field
and refer to the tool tip), you can see that
the rate of 525 ms is within the range
recommended by the DVB standard,

40 ms to 25000 ms.

Using the PES Analyzer

() 1.4 Continuity
=@ 1.5.2 PMT (228)

1.5 PMT (Timg A
: 31 5 pMT EScr ¥ Edit Parameters... ‘5|
~@18PD 1.5.a PMT
Q) Priority 2 The parameters for this test are listed below
@ Priorty 3(2) m
) Other 32 integer =

) SFM Errar

ormational Events
|

Nominal: 500

Maxc 25000

The elementary streams (including video, audio, and ancillary data) are combined into a packetized elementary stream (PES).
The header associated with each PES packet in a transport stream is of particular interest, as it contains the decode and
presentation timestamps (DTS and PTS) for the contained elementary streams. Errors in these timestamps may cause resets or
picture freeze problems at the receiver in extreme cases.

1.

44

Open the PES Analyzer. Start > All
Programs > Tektronix MTS4000 >
Analyzers > PES Analyzer.

Select File > Open. Locate and open
a transport stream. For example, the
TestMux.mpg file created in the Using
the Multiplexer procedure.

The analysis progress is displayed in
the status bar and the Event Log. The
Program Structure view is displayed
when analysis is complete. In this
example you can see that the stream
carries a single program, which contains
one video and one audio elementary
stream on PIDs 33 and 34 respectively.

@ MPEG-2 PES Analyser - TestMux.mpg

EEX

Staning Analpsis
000026 Analsis Complete Interval

b «| || PacketNumb=r [o Prog. 1 Yideo (PID 33) -

[Pes anaiyser [ NUM Tspacket 32
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3. Select the video stream in the Program
Structure view; the magnifying glass icon
will indicate that it has been selected.

4. Open each view option in the View menu,
that is, Event Log, Hex, Interpretation,
and PTS/DTS Timing. Each action opens
a new view in the PES Analyzer window.
It may be useful to tile the views in the
window using the Window > Tile option.

You can use the slider bar, above the
status bar, to navigate to any packet in
the PES stream. Packets are numbered
within a PID, according to their position
in the file. The slider bar displays the
packet number and the PID for the
current packet.

Packet Hex View:

In this view, you can examine every byte in
the PES.

B The four digit numbers in the left column
are the addresses of the first byte in the
row.

= The bytes displayed in magenta
represent the PES packet header.
You can view this as a graphical
representation in the Packet
Interpretation view.
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& MPEG-2 PES Analyser - TestMux.mpg
File Edit View Options Window Help
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DFE3 80 00 00 01 BS A

54 C3 D4 33 8A 33
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CE 26 03
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Packet Interpretation View:

This window interprets and displays a
graphical representation of the header of the
currently selected packet. The size of the
header will vary depending on the packet
content.

PTS/DTS View:

This view shows a timing analysis of the
selected stream. The X-axis shows the
duration of the stream in seconds. The
Y-axis shows the differences between the
expected and actual DTS values. Vertical
blue lines show the difference between
the PTS and DTS for each access unit.
Additional access unit information is shown
in the side panel.

A compliant stream will show each DTS on
the 0 ms Y-axis; streams with errors usually
show a stepped graphical effect.

Select the toolbar magnifying glass and click
on the view to zoom in and out of the graph.
The slider at the bottom of this window
indicates where the displayed packets are in
relation to the rest of the file.

46

& MPEG-2 PES Analyser - TestMux.mpg
File Edit View Options Window Help

Hw| &% @ml Bl
@ TestMux.mpg - Program St

=) Program 1
13, Video, (PID 33,0x0021)
(P10 34 000

@ TestMux.mpg Header Interpretation - Prog. 1 Video (PID 33) PES Packet 1529

EEX
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code
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@ MPEG-2 PES Analyser - TestMux.mpg
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= Program 1
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Using the T-STD Buffer Analyzer

Procedures

The T-STD Buffer Analyzer models the behavior of the buffers in the hypothetical Transport Stream System Target Decoder, as
specified in ISO/IEC 13818-1. It can process video, audio, and system control streams. The results of the analysis are displayed
as graphs of the buffer capacity over time and a log of exceptions and noteworthy events. The consequences of non-conformance
to the buffer model can include freeze frames and receiver resets.

1. Open the T-STD Buffer Analyzer. Start
> Program > Tektronix MTS4000 >
Analyzers > Buffer Analyzer.

2. Review the configuration settings. View
> Settings.
In the System tab of the Settings
dialog box, select MPEG2 Packet
Interpretation and select Pre-Scan
Packets All Packets.

MTS4000 and MTS4SA Quick Start User Manual

IM 7-STD Buffer Analyser.
Fle View Help

EEX)

Dl E| | S| & m=forla ]| [w 2] 4] alal=]

System | Video | Audio |

Packet Interpretation

Pre-Scan Packets

v Al Packsts

|1DDDD packsts

IAC—B Audio vI PES Private Interpretation

Y

Cancel
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3. In the Video tab, select Buffer
Sizes, Automatic and Data Transfer,
Automatic.

4. In the Audio tab, select Buffer Size,
Automatic.

5. Close the Settings dialog box.

48

Settings

System  Video ]ﬂudio |

x]

System] Video Audio ]

Buffer Sizes Data Transfer
{* Automatic
" Manual " Leak Method
" VBV Delay Method (MPEG-2 onl
ME : Bytes = ( W)
EEB: Bytes
Default Frame Rate
25 j Frames/s
oK p] cancel |
Settings g|

Buffer Size

" Manual
B: Bytes

AAC

2 | Default channels

oK h Cancel
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6. Select a file for analysis. File > New.

| 54 afalx] of

7. Locate and open an MPEG file. For ’
example, the TestMux.mpg file created in Rl

- PID 33 Stream Type: 2 (0302) (MPEG-2 Video) Unprocessed

the U Sing the Multlple xer procedure. 1 PID 34Stam Types 3 (0403) (4PEG-1 Auc) Unprocessed

Another file selection dialog box is
opened immediately. This is for you to
name and open a buffer model results
(BMR) file, which will hold the results of
subsequent analysis.

Accept the default name and open the
file.

The program performs initial analysis
to form a Stream List and calculate

the mean transport rate. The stream
list displays all of the programs and
elementary streams in the file. All
streams in the list are marked as
Unprocessed, because no analysis has
been performed on them in this session.

8. Select Process Streams from the

transport stream context menu to start . na

processing the stream. " 7

Analysis progress is displayed in the = (3 Program 1 Frocess Sreams
status bar. ~{E) PID 32 (Syste

<= PID 33 Strea
JJ PID 34 5trea

fideo) Unprocessed
hudio) Unprocessed

Buffers

Global Event Log
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9. Highlight PID 33 and select All Buffers
from the context menu.

The following windows will be displayed
for a video elementary stream: PID
Event Log, Video Transport Buffer, Video
Multiplex Buffer, and Video Elementary
Buffer. (The Stream List window has
been minimized.)

10. Tile the resulting windows: Window >
Tile.

PID Event Log:

You can open two event logs: a global event
log (View > Global Event Log) that displays
high level events occurring in the initial
analysis process and a PID event log (View
> PID Event Log) that displays events for
each processed PID.

In the following buffer graph views:

®  Use the toolbar magnifying glass icons
to zoom in and out of the selected graph.
Zoom value can be reset using the Reset
Zoom toolbar button.

= All open graphs can be viewed and
manipulated separately. Use the Options
> Synchronize Views to synchronize all
views with the currently selected view.

®  Red y-axis lines indicate the 0% and
100% limits.

Video Multiplex / Main Buffer:

In this view, for video streams, you can see
the results of modeling a multiplex buffer.
For audio and system control streams, you
can see the results for the main buffer. The
title bar shows the stream type.

Video Transport Buffer:

This view shows results of modeling the
transport buffer for video, audio, or system
control streams.

[T T-STD Buffer Analyser - TestMux.bmr

Ele Edit Vew Options Process Trace Window

D|=| 7| &) 59| | =2 c]

Help

[~ w4

YISy

B TestMux.bmr - Event Log for PID 33

Tme TsPacket | EventType Comment

(CIDI[R) [ hvideo iranspore e

0:0.000
0:0,000
0:0.000
0:0.000
0:0.000
0:0.000

General Event Fr

00,000 0 Log Started Starting the Video buffer model

General Event Level; Main Profile; Main

General Event T8 size: 512 bytes, R

Genersl Event M size: 10000 bytes, rate: 1675000 bytesfs
General Event €8 size: 220376 bytes

General Event Leak Method being used

- 200.0%

ame Rate = 25,00

T 1800%

BRLTES

T os00x

05 AL ML VLN AR L LU W A

- s00%
00000 0:24.000 0:48.000 1:12.000 1:36.000 1:60.000
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o ooz

. ooz

- s00%

0:0.000 0:24.000 048000

00000 0:24.000 0:48.000 1:12.000 1:36.000 1:60.000
1:60.000

1:12.000
1:60.000

1:36.000 1:60.000

|

le = [B] x

[sutter avaiyser
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Video Elementary Buffer:

This view shows only applicable video
elementary streams.

11. Select View > Trace to display the trace
log.
The trace log can help you analyze the
message logs produced by the Buffer
Analyzer. These logs may be useful
for in-depth analysis of the internal
processing, particularly for the video
stream type. The trace view has filtering
capabilities that allow you to focus on
message types of particular interest.

MTS4000 and MTS4SA Quick Start User Manual

[M T-STD Buffer Analyser - Trace.

fle Edt Vew Optons Process Trace Wind
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D|=#|w| 5| &l2 S| ===

# Testhuxbmr, = -~
Eere S Testhuc br - Trace

¥ Video Multipl

[Buffer Analyser

[~ wizls] ala

Time
B
Time
B
Time
B
Time
B
Time
B
Time
B
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Using the Elementary Stream Analyzer

The ES Analyzer checks for compliance of CODECs to MPEG-2 and H.263 standards. Audio decode and waveform display
of MPEG-2 audio (ISO/IEC 13818 parts 3 and 7), AC-3 and MPEG-4 AAC are also supported.

ES Analyzer is a complex application which you can use to analyze many aspects of video and audio streams. For this reason,
the following procedure shows you how to access some of the analysis screens; detailed explanation of their content and meaning
can be found in the MTS4000 Analyzer Application User Manual.

1. Open the ES Analyzer. Start > All 16" Tekronis MPEG-2 5 Anayser - [Tesihoc mpg] 5
Programs > Tektronix MTS4000 > T a— I T . -

= | Q| 7= Q
Ana]yzers >ES Ana]yzer. By | X Trorapat Facket Heeeler
= é;oi:(r:‘lnzﬁ) Ve 2 o FID [l PacketType [FEs  TransporEnorindistor 3¢
) \ . oS B0 —34), HPEG < Aucio tansput Seranbing Cortol [Not Scampied | 44361310 Fied Cantl ioag Ui Star v
2. Select a file for analysis. File > Open. s T | st i st S B
3 ‘Adaptation Field

LoCate and Open an MPEG flle For Adaptation Fisld W& SplcsCountdown & RandomAcosss indioator
. . PCR Base PCR Exterision £ Pioity Indicator )
example, the TestMux.mp file created in B Gtan o e

the Using the Multiplexer procedure.

[

Adaptation Fiekd Eension

AF Estension Length Ma Splice Type N LTw Offset  [NA
DTS Newt A Fiecewise Rtz A LTu#Vald Flag ®
Stream Property
+ Fie Name Calstreams\symTestiux.n
« Fie Size 353437 K8
o SteamType:  Transport
+ Video Tracks :
& Audio Tracks : 1
* Type of Video Mpeg2
* Typeof Audio:  Mpegi
o User Data Streams:0
* Total Programs: 1
LocaTion MESSAGE
[For Help, press F1  — Padketz 1 PID18 packet =1 O 0x0(0)

3. Click on each successive node in the 8 Tektronix MPEG-2 ES Analyse - TestHux.mpe]

. . . . | Fe Edt Vew Wndow Node Settings Help NEE
navigation window until the GOP (Group sloalF [ ] |0lokhiba s G
of Pictures) is highlighted in the Program S T e [ oo | a
. = GOP Header
1 / PES (PlD 33), MPEG 2 VldeO branCh = :TZ?::;WEG””“ DropframeFiag % CosedGOP 9 Brokenlik &  TmeCode [049678  GOPNumber |1
Showing in Presentation Order
& PES(l:-’I-D.M G 1 Audio D . > . . 1
e
Ficturs Size Bytes) 7198 Temperal Reference 0 VD [06TSs
UserData Sze [0 Foward Feode  [7 Forward Vector  [Half Pel

Backward F-code . Backwand Veetor [Ha Pel

Picture Coding Extension

. — reViCFoma & It OC Precison 5
Forwand Horgontal [ | 1% P st Atemate Scan x Picture Stucture [Frame Prture
@ Scale Type [Non Li
e e o e et st Pk 96 Frame Prediction Frame DCT |36
Forward Vetical & x
Progressive Frame Consesiment Moton Vectors (36
Cvoma 40Ty | onceaiment Maton Vectors

Backward Horzontal 5| Camposte Dislay

= Ve ® SbCaerfhse A

o Fie Name ColstreamsisymTestiux.n Bockward Vetieal [§ || Feld Secuence  [Nx ®

- s gl Sub Carrer Burst Ampitude NA

o SteamType:  Transport

* Video Tracks 1

* Audio Tracks : 1

« Typeofvides:  Mpeg2 B OME \ & CE \ & roe \ NESSE \ Q@PTSE \ B oo \ @4 CPE \

* TypeofAudo:  Mpeg!

* User Data Streams:0 Q

o Towl Programs: 1 Load Intra Guantzer Matitx %

< >
LocATIoN [ressace I
1000 TPT->PES(FID=33), MPEG 2 Video->VES(22... Inifiaizing VES stream
€ 1005 TPT-=PES(PID=33), MPEG 2 Video->VES(22... This is an MPEG-2 Video Elementary Stream
[For Help, press F1  —— PESPkt#:2. [TPTPkt#: 2429 GOP#1 Pic#1 Display #0 Off 0x6722(456482)
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4. Select the Picture Player tab. Note that = Tekons -2 & o . - lo/x]|
the Picture Player remote control is =

= | o Q ®
displayed' = &T;DROGMM] GOP And Piotwre | Slice And MB Pctare Wayer | ]
: 7 PES{PID =33), MPEG 2 Vide
5. Click the Show Information button to = e 20 bl

e ayingi2s Tesiu: mp O ComaNs  Depey e

expand the control bar. The extra R BINR I PN £ DN
information shows the position in the file
of the displayed picture; more information
is shown in the status bar.

15. FLOWER

GARDEN

< >
Stream Property | Value ~
 Video Tracks

o AudoTrads: 1

* Typeofvden: Mpeg2
« TypeofAudo:  Mpegl
« User Data Streams:0
o Total Frograms: 1
< 3 &
LOCATION [ Essace ]
1000 TPT->PES(PID=33), MPEG 2 Video->VES(2Z... Initialzing VES stream
1005 TPT->PES(PID=33), MPEG 2 Video->VES(2... This is an MPEG-2 Video Elementary Stream
1173 TPT->PES(PID=33), MPEG 2 Video->VES(22... No images from previous GOP are available, Playing GOP# 1 may show hazy results

For Help, press F1 | — TPTPKES:35 GoP#L = Display 1 Off Ox18fd(6397)

6. Start playing the stream by clicking the
play button on the control bar.

If you stop the playout, you can select the
other GOP tabs (GOP and Picture, Slice
and MB), and examine the characteristics
of that frame.

IR e

7. For example, select the Picture Display 55" Tektronix MPEG-1 ES Analyser - Testioc mpe]

. . . W Ele Edit Vew Window Node Settngs Help HEE
on the Slice and MB tab. The picture will . = T
. . . = Bx Q G@ ?
correspond to the picture in the Picture & bt Fonwe | S A MR | m Pl | 3
Player. =) ) PesEPD=33, vES 2 BFRAME [«al>>]
(:
8. Click Show MV (motion vectors) on the
right of the picture display. For B and
P frames, the motion vectors will be
displayed as colored arrows overlaying
the picture.
<
Stream Property Value Al
® Video Tracks
= Audio Tracks 1
* Type of Video Mpeg2 Shices
:E:zf;;;“::é‘ms::m‘ Priorty Breakpoint [NA  Quantizer Scale [19 Sice Exension flag ) Intra Sice @ Picture 1D [N Row Mumber [1
* Total Programs: 1 ] Macroblock: - K
LOCATION [vEssace |
1000 TPT->PES(PID=33), MPEG 2 Video->VES(22... Initislizing VES stream
1005 TPT->PES(PID=33), MPEG 2 Video->VES(22... This is an MPEG-2 Video Elementary Stream
1173 TPT- , MPEG 2 Vids s No images are avaiable. 1may show hazy results
1240 TPT->PES(PID=33), MPEG 2 Video->VES(22... In the picture play mode macroblock | errors are not flagged.
1173 TPT->PES(PID=33), MPEG 2 Video->VES(22... No images are available 57 may
[For Help, press F1 I — PESPkt#:698 [TPTPkt=: 1240 (GOP#59 Pic#697 Display #6356 Off Dx50b9456{84644950)
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Additionally, you can see the
characteristics of any of the macroblocks

that make up the picture by hovering the I
mouse over a picture macroblock. L @

) (D R T [

| 7 (o e S e ]

Macroblock Mumber @ 605

Motion Vector Parameters(in units of Pixel):
MY Backward Frame w:-1.5, v: 0.0

Other Parameters;
MEB Intra = FALSE

- DCT Type = MA
= MB Quantizer Scale = 16 T
= cBpP = (000000 %
=l MB Size (its) = 13
] =
el i ae

e

9. Use the Previous Frame and Next Frame
buttons to move backward and forwards
in the stream and compare the motion ﬂltl
vectors.

You can examine the characteristics of ClERE RS
the audio stream in a similar manner. =cal [ Jaloe o = 2 '
. ) ) =gl T WP | Hlauloe | o
10. Click on each successive node in the e rero-sa 2| I
navigation window until the GOP (Group o o T - - e %

A . . . . (B PESPII=39), WPES 1 Auc Birate [62kbps Sampling Frequency  |48.0kHz Padding Bit x
of Pictures) is highlighted in the Program @@k T R

1/PES (PID 34), MPEG 1 Audio branch. e D e X
Use the audio control bar to review

the audio track. You will need to use —
headphones to hear the output. T [ | s

Left Channel Audio Play

T Device | SoundMaX Digital Audio +| grral
=
E Play Channels [Left Right Channel .
=
z

< > é

Stream Property | Value A ®

« Video Tracks : %)

o

- AudoTradks: 1 ] L R

&

« Typeofiidea:  Mpeg2

© TypeofAudio:  Mpeg1
« User Data Streamsi0

« Total Programs: 1 5

< > ~

LOCATION [ vessace ~
1173 TPT->PES(PID=33), MPEG 2 Video-=VES(22... No images from previous GOP are availeble. Playing GOP# L may show hazy results
1240 TPT->PES(PID=33), MPEG 2 Video->VES(22... In the picture play mode macroblock level errors are not flagged.
1173 TPT-5PES(PID=33), MPEG 2 Video-=VES(22... No images from previous GOP are available. Playing GOP# 57 may show hazy results
2033 TPT->PES(PID=34), MPEG 1 Audio->AES(L... Initalzing AES stream ~
< >
For Help, press F1 I ——— ) TRTRKE= 1040745 ditsfs Laver2 Frame=2704 __|Off 0xbas3872(195653550)
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TSCA FlexVuPlus™ Display

Procedures

In the Transport Stream Compliance Analyzer, you can use the FlexVuPlus, to select up to four views from the analysis detail
views to be displayed together to facilitate basic transport stream monitoring or more detailed diagnostic monitoring.

For this exercise, close each of the currently
displayed FlexVuPlus panels by clicking the
X in the top right corner of each panel.

This is not necessary, but it may help you
visualize the following procedure more easily
as each panel is populated. Note that each
of the four FlexVuPlus panels are numbered.

Set up panel 1

1. Select the Analysis tab and then the
Tests tab.

In the top right corner of all detail views
is a FlexVuPlus panel select button.
You can use this button to display a
replica of the detail view in the selected
FlexVuPlus panel.

2. In the Test Summary view, use the
FlexVuPlus panel select button to
replicate the view in panel 1.

MTS4000 and MTS4SA Quick Start User Manual

@ C:\Streams\Sym\Sym1.mpg - MPEG TS Compliance Analyser

B Send to FlexVuPlus™ panel s ) Send to Flexupu

@ ™ 101 290 (74) | @ Other (39)| O S Eror| 4 EventLog

EBX

Transport Stream: Id 1, Network Name: ADHERENT NETWORK

@ Analysis tzb,

15 Avaisbity Q)| Sync Q]| 41.470556 ops @ 155165 1,650,000 Packets 0V | o Extensions )

@ C:\Streams\Sym\Sym1.mpg - MPEG TS Compliance Analyser

B Flexvuplus™ | £ Analysis

Progeams| Tests | s1/si | PIDs | Packets
Adions v show: @ ¥ @ | % [ =)

= @ Stream Tests (108) * Priority 3 (74)

@ 3.L.aNIT Acual

grim 9
#-(Q SFNError Q 1.25yncByte ] Q 3.1b NIT Other
5@ omatons Everts Q 13.0a1 92 @ 3251 Repetiion
@ 1.4 Contiuty @ 2.3 PCR Discontinuty Indester | @ 3.4.2 Unref PID
@ 15.0MT @ 2.4PCR Acauracy @ 352507 Actual
@ 16PID @ 25PTS Q 3.5 SDT Other
@26ca @ 3.6.3EIT Actual 72)
Q 36bEIT Other
@ 36.CETPF(2)
@ 37RsT
@381

panel2

o sendtoFi panel3

0 Send to FlexVuplus™ panel 4

75 Avaiabity @ |Sync Q|| 41.470996 Mops @ 188|188 1,650,000 Packets| | DVB | |No Extensions | [l B
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3. The FlexVuPlus display now contains the S Sy g MOEG T Complce A
Test Summary view in panel 1. b | .

@ 2.1 Transpart @ 3.1.aNIT Actua
O 3.1bNIT Other
@ 2.3.2PCR Repetitin | Q) 3.2 Repetiton
2.3 PCR Discortiuity I
2.4PCR Accuracy
25615 he
2.6 CAT ) 5 Send to FlexVuPius™ panel 2 KT

e h bu
' Sendto Fexiuplus™ pancl 3l EETSIEIRTEl fom the men that appears

75 Avaisbity Q) |Sync @] 41.470596 Mbps @ 165 159 1,650,000 Packets OVB o Extensions | [ B X

Set up panel 2.

4. Select the Analysis tab and then the
Programs tab.

5. In the Thumbnails view, use the eSS T e

Analysis View Navigation Settings CaptureVu™ Help

FlexVuPlus panel select button to
replicate the view in panel 2.

B Flexvuplus™ | £ Analysi:

Programs | Tests | eS| PIDs| Pacets
acions v | @, @ E

5@ Transport Stream: Id 1, Network Name: ADHERENT nable Thumbnais Display Format: |[)| (5] § ™ Send to FlexuPlus™ panel 1
‘Q Program 1 (@x01) Adherent | ' —
‘Q Program 2 (8x02) Adherent Il &
‘Q Program 3 (2x03) Adherent Il '
12 Q Program 4 (0404) Adnerent IV 1
Q@ Program 5 (0x05) Adnerent V &

® Adnerent! ® Adnerentl

o Send to FlecVuPlus™ panel 3

o Send to FlexVuPlus™ panel 4

FLOWER
GARDEN

® Adnerentl ® Adnerent IV

75 Avaisbity Q) |Sync @ 41.470596 Mbps @ 165 159 1,650,000 Packets| DV o Extensons | B
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6. The FlexVuPlus display now contains the
Thumbnail view in panel 2.

Set up panel 3.

7. Select the Analysis tab and then the
Tests tab.

8. In the Test Failures view, use the
FlexVuPlus panel select button to
replicate the view in panel 3.

MTS4000 and MTS4SA Quick Start User Manual

@ C:\Streams\Sym\Sym1.mpg - MPEG TS Compliance Analyser

Analysis_View Navigation Setings CaptureYu™ _Help
>

tandard... | Configuration.

O sFivEmor

2.1 Transport

Q 3.1.aNT Actual
O 3.1bNIT Other
@ 3.251 Repetition

2.3.2PCR Repettion
2.3.b PCR Discontinuity 1
2.4PCR Aceuracy
25pTS

26 CaT

Procedures

Thumbnais

Enable Thumbnais

® Adnerent|

15. FLOWER
GARDEN

£ Sendto FlexVuPlus™ panel 3

m the menu that app:

75 Avalsbity Q| [Sync @[ 41.470996 Mops @ 18] 18] 1,650,000 Packets [ DV o Extensions

ture o
Any view from the

ct TSRSl from the menu that app:

il G

B Flexvuplus™ | S Analysis |

Programs| Tests | siypst | PIDs | Packets

actions v | showi @ ¥ @ 9 [ E

= @ Stream Tests (108)
@ TR 101 290 (74)
@ other 34

S Eror
Informatonsl Everts

i @ 1.4 Contiuity

Q 152007

Q167D

© 2.1 Transpart

@220k

4)
@ 3.L.aNT Actual

2.3.PCR Repetiion

25pTS
26 CaT

2.3.b PR Discortinuity Indicator
2.4PCR Acaracy

Test Fares | 4 Event Log!

Fied withi the sz update ()

@ EIT P Presence (1)
@ EIT P Presence Consistency (1)
@ersyniax (34)

Test Failures (new additions shown shaded)

@ EXT Actual PF Min Any Section Reptn Int (72)

B Send to FleVuPlus™ panel 1
5 Send to FlexVuPlus™ panel 2

Fied outsie the st updte 0)

d to FlexVUPIus™ s

o Send to FleVuPlus™ panel 4

75 Avaisbity Q) [Sync @[ 41.470996 Mops @ 158] 168 1,650,000 ackets|[DVE o Extensions

il G
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9. The FlexVuPlus display now contains the .C\StramsSm\Smi. oz HPEG TS Cmpiance Anlyser EED

Analysis View Navigation Settings CaptureVu™ Help

Test Failures view in panel 3.

Enable Thunbnais Dilay Forma )| [=) )

O

© 1.5yme 5 @ 3.1.aNT Actual ) el

Q 125wmeye 92 O 316 NIT Other

@ 13004 @ 23.3pCRRepettin | Q3251 Repetion

@ 14 Contiuy @ 2315 PCR Disconinty L. | @ 3.4 Unvef 7D

Q 1s.ap @ 214 PeR Acauracy @ 352507 Actal

Q 16PD @ 25PTs 15. FLOWER
@250t 2) GARDEN

Test Failures (new additions shown shaded)

i )
‘@ EIT Actual P Hin Ay Secton Reptn It (.
@ EIT PIF Presence (1)
‘@ EITPIF Presence Consistency (1)
@ersyniax (34)

15 Avaisbity Q) |Sync Q]| 41.470596 Mps @ 185 159 1,650,000 Packets | 0VB o xtensons| | [ B

Since only three panels are used in this
example, you can expand the thumbnails
view to fill the right side of FlexVuPlus™.

You can expand panel 2 vertically by
selecting the panel expand button.

(Similarly, you can expand panels
horizontally using the horizontal panel p
expand button.)

Enat

10. Expand panel 2 to display the complete S eSS g MPEG TS Conplnce s BER

Analysis View Navigation Settings CaptureYu™ _Help

FlexVuPlus basic monitoring view.

X
Enable Thunbnais Dilay Forma )| [=) )

@ 1.15ync

® Adnerent|

Q 125ymcyte Q2

Q 13.apaT @ 23.2PR Repettion | Q) 3.2 1 Repettion

@ 1.4 Contiuity @ 2.3 PCR Discontiruity 1. | @ 3.4.3 Unvef PID

Q 152007 @ 2.4PCR Acauracy @ 3.5.2507 Actal

Q@ 16pD @25°Ts Q) 3.5b DT Other 15. FLOWER
Q26T @ 3.6 Actusl (72) GARDEN

® Adnerentl

)
"y Section Repin It (.

@ EIT PIF Presence (1)

‘@ EITPIF Presence Consistency (1)

@ersyniax (34)

5 Avaiabiity @)/[Sync @) 41.470996 Mbps @ 188188 1,650,000 Packets| | DVB|[No Extensions| |l . LY
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To summarize, in this view you can immediately see the following:

B |n the Tests Summary view (FlexVuPlus panel 1), which tests have failed.

B n the Test Failures view (FlexVuPlus panel 3), which tests have failed most recently.

B |n the Thumbnails view (FlexVuPlus panel 2), which elementary streams are currently carrying video content.

Multiple Input Monitoring

The MTS4000 system is capable of monitoring multiple transport streams (on separate 10 G or PC NIC ports) using multiple
instances of the Transport Stream Compliance Analyzer.

1. Open Transport Stream Compliance
Analyzer. File > Program >
Tektronix MTS4000 > Analyzers
> TS Compliance Analyzer.

Select Real-time Analysis... in the
TSCA Analysis toolbar.

2. In the Select Real-time Interface dialog
screen, select an available input from the
Interfaces pull-down menu.

In the example the, ASI-3 input is selected
to monitor for this instance of the TS
Compliance Analyzer application.

The choices available are dependent on the
available optional inputs.

MTS4000 and MTS4SA Quick Start User Manual

[E2 1P - MPEG TS Compliance Analyzer
Analyss tiew Havigation Settings CaptureVu™ Record Help

P FlexvuPlus™ | O Analysis

rosrans | Teats | siest | Pibs | packats
actons v | @ & )

O NopaT

[ Select Reab-time Intrface =

Standerd
Base Standard DVE, Region No Extensions -
Using default scrpts. Scripted validations are not enabled. 9e-:

Interfaces

Show fter @

Select from the avalable interfaces [H5E3) =

Interface Settings

O 3.1 NIT ther F
O 3.257 Repettion L

O 12symesyte
O13apa1
O 1.4 Continuity
Q15apMT

O 16rm

3 A6 FIT Other

15 avalabity @) [sync O] 0.000000 Mps @ 15810 0w o Extensions| ncetaces 1 o) | B

h

E\! Select Real-time Interface

Standard

Base Standard DV¥B, Region Mo Extensions
IUzing default scripts. Scripted validations are nok enabled. S
Interfaces

ASI-3
ASI-4

Interface Settings

Mlax

Yalue |::| (K rauninal
Time Stamping [V tue | | | |

” apply H Cancel ]
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3. Open a second instance of the Transport
Stream Compliance Analyzer. File
> Program > Tektronix MTS4000 >
Analyzers > TS Compliance Analyzer.

Select Real-time Analysis... in the
TSCA Analysis toolbar.

4. In the Select Real-time Interface dialog
screen, select an available input from the
Interfaces pull-down menu.

For this instance of the TS Compliance
Analyzer, ASI-4 input has been selected to
monitor.

60

P Flexvuplus™ | £ Analysis

Progas | Tests [ Siest| s | ket

[ summary | Trumbneats | 7 Graphs | HPE Sessions
acors v | % @ E]

O NopaT

of Programs o
TS it rate abps

¥ Select Realtime Inteface

Standard

==

Show fiter @

Change... |

enabled

Interfaces

Select from the avaliabl interfaces A1) =

O Lisme
O 1.25yncByte

O zscar

O 2:3b PCR Discontinuity Indicator

Q13.apar

O 1.4 Continuky

Q 15.apmT Q 24 PCR Accuracy
O LoD Q 25pTs

© 3.L.aMIT Actual P
(O 3.1b NIT Other E
O 3.251 Repstition L
O 3.4.5 Unvef PID

5 Availabilty @) Sync () | 0.000000 Mops @ 188 |0 |DVE | No Extensions | Interface: 17 (UoP) | [l B

h

E\l Select Real-time Interface

Standard

Base Standard DYE, Region Mo Extensions

Interfaces

Select from the available interfaces

Interface Settings

Hol-
i

Field
Tirne Stamping

Yalue ()

Using default scripts, Scripked validations are not enabled.

Ve

roninal Max

][ Apply ][ Cancel ]
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Accessories

Accessories

Standard Accessories

The following table lists the standard accessories that are shipped with the MTS4000 instrument:

Description Part number MTS4000 MTS4SA
Compliance certificate 001-1180-XX = =
Software CD-ROM: MTS4000 Application Software Media 063-4385-XX = u
Certificate Of Authenticity: Microsoft Windows 7 NA =

Software DVD: MTS4000 Operating System Restore DVD 063-4387-XX |

MTS4000 Product Documentation CD-ROM 063-4386-XX = =

The CD contains all documents supporting the MTS4000 and its
software applications.

MTS4000 and MTS4SA Quick Start User Manual 071-2970-XX ] n
Supplemental information sheet; China ROHS 071-2185-XX = =
Hardware key (dongle), USB NA u u
Power Cord (one of the following) NA u

North America (Option AQ)

Universal Euro (Option A1)

United Kingdom (Option A2)

Australia (Option A3)

North America 240 V (Option A4)
Switzerland (Option A5)

Japan (Option A6)

China (Option A10)

India (Option A11)

No power cord or AC adapter (Option A99)
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Options and Upgrades

Options

The following table lists the available hardware and software options that you can order with the MTS4000. Accessories
included with the options are also listed.

Option Description
Hardware options
ASI Multiport ASI Interface.
Up to four output ports. Ports 1 and 2 reserved for RF and IP cards. Ports 3 and 4 are
available to receive.
S2 DVB-S/S2 Interface supporting QPSK, 8PSK, 16APSK, and 32APSK Demodulation (requires
Option ASI).
Includes BNC to BNC 75 Q cable (Tektronix part number 174-5135-xx).
VS 8VSB Interface (requires Option ASI).
Includes BNC to BNC 75 Q cable (Tektronix part number 174-5135-xx).
QB2 QAM B Interface (requires Option ASI).
Includes BNC to BNC 75 Q cable (Tektronix part number 174-5135-xx).
IPTV IPTV Gb Ethernet Interface with 10/100/1000BASE-T RJ45 Electrical Port (requires Option
ASI).
Includes BNC to BNC 75 Q cable (Tektronix part number 174-5135-xx).
SX 1000BASE-SX Short Wavelength SFP Optical Port with LC Connector for IPTV Ethernet
Interface (Multi mode 850 nm).
LX 1000BASE-LX Long Wavelength SFP Optical Port with LC Connector for IPTV Ethernet
Interface (Single mode 1310 nm).
ZX 1000BASE-ZX SFP Optical Port with LC Connector for IPTV Ethernet Interface (Single mode
1550 nm).
10GS 10GBASE-SR Dual Optical Port 10 Gb/s NIC. Includes Short Reach SFP+ Modules (850 nm).
Software Options
GEN Multiplexer, MPEG Player, Transport Stream Editor, Make Seamless Wizard, Transport Stream
Cutter, and Script Pad.
Includes Tclips MPEG Test Stream software media.
ESS Standard ES Analysis. Includes MTS4CC with all options plus MPEG-2 ES Analyzer.
ESE Enhanced ES Analysis. Includes MTS4EAB with all options plus MPEG-2 ES Analyzer.
vVQ Video Quality Software, Single Ended. Includes VQS1000 with all options.
PQ Picture Quality Analysis Software, Single and Double Ended. Includes PQASW with Option IP.
PB PES and T-STD Buffer Analyzers.
Package Option
430 Includes: Player, Multiplexer and Tclips Test Streams, PES and Buffer Analyzers, MTS4EAB

with all options, MPEG-2 ES Analyzer.
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Upgrade Kits

Accessories

Upgrade kits are available to enhance the capabilities of the instrument after you purchase the MTS4000 test system.
Kits may contain software, hardware, or both.

A qualified technician is required to install hardware to the instrument.

Option Description
MTS4KUP

GEN Multiplexer, MPEG Player, Transport Stream Editor, Make Seamless Wizard, Transport Stream
Cutter, and Script Pad.
Includes Tclips test streams media.

ESS Standard ES analysis. Includes MTS4CC with all options plus MPEG-2 ES Analyzer.

ESE Enhanced ES analysis. Includes MTS4EAB with all options plus MPEG-2 ES Analyzer.

VQ Video quality software, single ended. Includes VQS1000 with all options.

PQ Picture quality analysis software, single and double ended. Includes PQASW with IP option.

PB PES and T-STD Buffer Analyzers.

ASI Multiport ASI interface (four ports)

S2 DVB-S/S2 interface supporting QPSK, 8PSK, 16APSK AND 32APSK demodulation.

VS 8VSB interface.

QB2 QAM B interface.

PTV IPTV GIGABIT Ethernet interface with 10/100/1000 BASE-T RJ45 electrical port.

10GS 10GBASE-SR dual optical port 10Gb/s NIC. Includes short reach SFP+ modules (850 nm).

SX 1000BASE-SX short wavelength optical port with LC connector for IPTV Ethernet interface
(multi mode 850 nm).

LX 1000BASE-LX long wavelength optical port with LC connector for IPTV Ethernet interface
(single mode 1310 nm).

ZX 1000BASE-ZX optical port with LC connector for IPTV Ethernet interface (single mode

1550 nm).
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MTS4000 System Recovery

MTS4000 System Recovery

If you have problems with the MTS4000 system software, use the procedures in this section to restore the system to the
factory default installation and configuration.

A complete system recovery involves restoring the Windows Operating System and reinstalling the MTS4000 MPEG
Test System software.

A system recovery affects the primary hard drive (C:). The secondary hard drive (D:) is not affected by these procedures.

NOTE. If you are restoring software after replacing the primary hard drive with one that you ordered from Tektronix, follow
the instructions provided with the hard drive replacement kit.

Restore the Operating System

You can restore the instrument operating system from either a file on the instrument hard disk drive or from the instrument
restore DVDs. The preferred restore method is to use the hard disk restore file.

CAUTION. To avoid data loss, back up any important user files stored on the hard drive. This operating system restoration
[ ' S process reformats the primary hard drive (C: drive), which erases any user-installed files and applications. The secondary
hard drive (D: drive) is not affected.

If Windows does not boot, you may be able to start the computer from the Last Known Good configuration.

To avoid malfunction, do not install any version of Windows that is not specifically provided by Tektronix for use with your
instrument. The version of Windows is specially configured for the instrument. Other available versions of Windows will
not operate properly.

Restoring the Operating System from the Instrument Hard Disk

The instrument contains an operating system restore file on a separate partition of the hard drive.

1. Restart the instrument. During the boot-up process you will see the following message at the top of the screen:
Starting Acronis Loader... press F5 for Acronis Startup Recovery Manager

2. Repeatedly press the F5 key until the Acronis True Image Tool opens. There is a 5-second time period from when the
message appears until the instrument proceeds with the normal instrument startup. If the instrument does not open the
Acronis application, power off the instrument, then power on the instrument and try again.

3. Click Recover.

4. In the Confirmation dialog box, click Yes to restore the instrument operating system, or No to exit the restore process.
The restore process takes approximately 30 minutes; the actual time depends on the instrument configuration.

5. When prompted, either shutdown or restart the instrument.

6. Install the MTS4000 System Applications.
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MTS4000 System Recovery

Restoring the Operating System Using the OS Restore DVDs

The procedure to restore the instrument system software requires the MTS4000 MPEG Test System Operating System
Restore DVDs (063-4387-XX), supplied with the MTS4000 instrument.

1. Insert disk 1 of the Operating System Recovery media into the DVD drive of the instrument, and close the drive door.
2. Reboot the instrument.

If the instrument does not reboot from the DVD, reboot again:

= Repeatedly press the F11 function key during the boot process, until a boot drive menu is displayed.

= Select the CD/DVD as the boot device, and press Enter. The instrument should now boot from the DVD.

NOTE. If necessary, use the keyboard arrow keys to select the required restore option.

3. When prompted, select Recover the original system installation, and then press Enter.

4. Press Enter to proceed with the installation. The restore process begins.

NOTE. Please be patient. For the first 10 minutes while files are being copied, the progress bar will not show any activity.

NOTE. Follow the displayed instructions. You will need to swap disks during the procedure.

Each time you insert a DVD, wait for the DVD activity light to stop blinking before checking OK or Retry. Failure to wait for the
blinking to stop generates a popup that pauses the install until you select OK.

5. When the Acronis restore process is completed, remove the restore disc.

6. When prompted, select either restart or shutdown to complete the OS restore process and either restart or power
off the instrument.

7. When prompted by Windows, select Restart Now to restart the instrument and finish installing all device drivers.

8. Install the MTS4000 System Applications.
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Installing the MTS4000 System Applications

The procedure for installing the MTS4000 system applications is similar to the procedure for stand-alone installation.

When installing the MTS4000 applications on the MTS4000 platform, select the Install on MTS4000 Platform during the
installation procedure and continue with the installation.

) Tektronix MTS4000 Setup (=]

Choose Setup Type
Choose the setup type that best suits your needs

¥ Install on MTS4000 Platform;

Back | Mext | Cancel |

After installing the MTS4000 applications, the software license key must be reinstated — this is described in the stand-alone
installation procedure. (See page 6, MTS4SA Stand-Alone System Installation.)
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User Maintenance

This section describes general care and service procedures for the MPEG Test System.
= Preventive Maintenance provides cleaning instructions
® |n Case of Problems provides some hints for troubleshooting startup errors

B Repackaging for Shipment gives instructions for packing and shipping the instrument

General Care

Protect the instrument from adverse weather conditions. The instrument is not waterproof.

c CAUTION. To avoid damage to the instrument, do not expose it to sprays, liquids, or solvents.

Do not use chemical cleaning agents; they may damage the instrument. Avoid chemicals that contain benzene, toluene,
xylene, acetone, or similar solvents.

Preventative Maintenance
Check the electrical performance and verify that the instrument accuracy is certified (calibrated) once a year.

Preventive maintenance mainly consists of periodic cleaning. Periodic cleaning reduces instrument breakdown and increases
reliability. You should clean the instrument as needed, based on the operating environment. Dirty conditions may require
more frequent cleaning than computer room conditions.

Cleaning the Exterior

Clean the exterior surfaces of the instrument with a dry, lint-free cloth or a soft-bristle brush. If dirt remains, use a cloth or
swab dampened with a 75% isopropyl alcohol solution. A swab is useful for cleaning in narrow spaces around the controls
and connectors. Do not use abrasive compounds on any part of the instrument.

CAUTION. Avoid getting moisture inside the instrument during external cleaning and use only enough solution to dampen
the cloth or swab. Use a 75% isopropy! alcohol solution as a cleanser and rinse with deionized water.

Do not wash the front-panel On/Standby switch. Cover the switch while cleaning the instrument.

Cleaning the Keyboard

Clean the exterior surfaces of the keyboard and integrated tracking device with a dry, lint-free cloth or a soft-bristle brush.
A swab is useful for cleaning in narrow spaces around the controls and connectors. Do not use abrasive compounds on
any part of the instrument.
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CAUTION. Avoid getting moisture inside the keyboard and integrated tracking device during external cleaning and use
only enough solution to dampen the cloth or swab. Use a 75% isopropyl alcohol solution as a cleanser and rinse with
deionized water.

In Case of Problems

This section addresses problems that you may encounter while using the test system. This section does not identify specific
problems related to performance verification or adjustments. The diagnostic procedures for the MTS4000 system provided in
this section can help you isolate problems. For a performance verification procedure, refer to the MTS4000 Specifications

and Performance Verification Technical Reference, supplied as a PDF file on the MTS4000 Product Documentation CD-ROM.

Power-on diagnostics run when you first power on the instrument to start the test system application. These diagnostics
check the operating system and hardware for correct operation. If error messages occur during the power-on diagnostics,
there may be a system error that prevents the MTS4000 system software from starting.

The following table lists some of the symptoms of hardware problems (related to the operating system and peripheral devices)
and possible solutions.

Symptom Possible causes and recommended actions
Instrument does not power on Verify that the power cord is connected to the instrument and to the power
source.

Check that the instrument receives power when you push the On/Standby
switch; check that fan starts.

Check that power is available at the power source.
Contact your local Tektronix service center.

Instrument powers on but does not complete Make sure instrument boots from the hard disk drive.
the power-on sequence

Power-on diagnostics fail Contact your local Tektronix service center.

Instrument does not recognize accessories Check that accessories are properly connected or installed.
such as external monitor, printer, or keyboard  contact your local Tektronix service center.

Instrument will not power off with On/Standby ~ Try powering off the instrument using the Windows 7 shutdown procedure.

switch If the instrument still does not power off, use the task manager to close
down tasks. Finally, try the hard shutdown procedure; push and hold the
On/Standby switch for five seconds to power off the instrument.

Software Problems

Your MPEG Test System comes with software already installed. For any suspected software problems, try to isolate the
problem to the test system application software or to other installed software.

Many software problems are due to corrupt or missing software files. In most cases, the easiest way to solve software
problems is to reinstall the software. (See page 64, MTS4000 System Recovery.)

If you suspect networking problems, see Network Troubleshooting. (See page 14, Network Troubleshooting.)
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Hardware Problems

Hardware problems can have several causes. Review the installation instructions in this manual to verify that you have
properly installed the instrument. There are no user serviceable parts in the MTS4000 system, so you should contact your
local Tektronix Service representative if you have a hardware problem.

Restoring the TS Compliance Analyser P1 Icon

If the TS Compliance Analyser P1 icon has been inadvertently deleted from the desktop, you can restore it by following
these steps.

1.

> 0

Copy the TS Compliance Analyser icon from either the desktop or the Start menu.
Select the icon, right-click, and select Properties.
Select the Shortcut tab.

In the Target field, add /p1 to the end of the target string.
The target string should be:
"C:\Program Files (x86)\Tektronix\mpeg\MTS4000\Apps\TSCA\bin\TSCA.exe" /pl

NOTE. Make sure to include a space between the “and /p1.

5.

Rename the shortcut icon, adding P1 to the end of the name.

Returning the Instrument for Service

When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use,
contact your local Tektronix representative to obtain new packaging.

1.

Seal the shipping carton with an industrial stapler or strapping tape. Before returning the instrument for service, contact
the Service Center to get an RMA (return material authorization) number, and any return or shipping information you may
need.

If the instrument is being shipped to a Tektronix Service Center, enclose the following information:
= The RMA number.

= The owner's address.

= Name and phone number of a contact person.

= Type and serial number of the instrument.

= Reason for returning.

= A complete description of the required service.

Mark the address of the Tektronix Service Center and the return address on the shipping carton in two prominent
locations.
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